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Preface

Obtaining Documentation

Cisco.com

Cisco documentation and additional literature are available on Cisco.com. Cisco
also provides several ways to obtain technical assistance and other technical
resources. These sections explain how to obtain technical information from Cisco
Systems.

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/techsupport

You can access the Cisco website at this URL:
http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD

Cisco documentation and additional literature are available in the Product
Documentation DVD package, which may have shipped with your product. The
Product Documentation DVD is updated regularly and may be more current than
printed documentation.

[ oL-11600-01
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[ | Documentation Feedback

The Product Documentation DVD is a comprehensive library of technical product
documentation on portable media. The DVD enables you to access multiple
versions of hardware and software installation, configuration, and command
guides for Cisco products and to view technical documentation in HTML. With
the DVD, you have access to the same documentation that is found on the Cisco
website without being connected to the Internet. Certain products also have .pdf
versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription.
Registered Cisco.com users (Cisco direct customers) can order a Product
Documentation DVD (product number “DOC-DOCDVD=") from Cisco
Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Ordering Documentation

Beginning June 30, 2005, registered Cisco.com users may order Cisco
documentation at the Product Documentation Store in the Cisco Marketplace at
this URL.:

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m.
to 5:00 p.m. (0800 to 1700) PDT by calling 1 866 463-3487 in the United States
and Canada, or elsewhere by calling 011 408 519-5055. You can also order
documentation by e-mail at tech-doc-store-mkpl @external.cisco.com or by fax at
1408 519-5001 in the United States and Canada, or elsewhere at 011 408
519-5001.

Documentation Feedback

You can rate and provide feedback about Cisco technical documents by
completing the online feedback form that appears with the technical documents
on Cisco.com.

You can send comments about Cisco documentation to bug-doc @cisco.com.

Installation Guide for Cisco Configuration Assurance Solution
m. oL-11600-01 |



http://www.cisco.com/go/marketplace/
http://www.cisco.com/go/marketplace/
mailto:tech-doc-store-mkpl@external.cisco.com

| Preface

Cisco Product Security Overview W

You can submit comments by using the response card (if present) behind the front
cover of your document or by writing to the following address:

Cisco Systems

Attn: Customer Document Ordering
170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

From this site, you can perform these tasks:
» Report security vulnerabilities in Cisco products.
» Obtain assistance with security incidents that involve Cisco products.
» Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at
this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you
can access a Product Security Incident Response Team Really Simple Syndication
(PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html
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Reporting Security Problems in Cisco Products

Cisco is committed to delivering secure products. We test our products internally
before we release them, and we strive to correct all vulnerabilities quickly. If you
think that you might have identified a vulnerability in a Cisco product, contact
PSIRT:

* Emergencies—security-alert@cisco.com

An emergency is either a condition in which a system is under active attack
or a condition for which a severe and urgent security vulnerability should be
reported. All other conditions are considered non emergencies.

* Non emergencies—psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:
o 1877 228-7302
* 1408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to
encrypt any sensitive information that you send to Cisco. PSIRT can work from
encrypted information that is compatible with PGP versions 2.x through 8.x.

Never use a revoked or an expired encryption key. The correct public key to use
in your correspondence with PSIRT is the one linked in the Contact Summary

section of the Security Vulnerability Policy page at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

The link on this page has the current PGP key ID in use.

Obtaining Technical Assistance

Cisco Technical Support provides 24-hour-a-day award-winning technical
assistance. The Cisco Technical Support & Documentation website on Cisco.com
features extensive online support resources. In addition, if you have a valid Cisco
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Obtaining Technical Assistance

service contract, Cisco Technical Assistance Center (TAC) engineers provide
telephone support. If you do not have a valid Cisco service contract, contact your
reseller.

Cisco Technical Support & Documentation Website

Note

The Cisco Technical Support & Documentation website provides online
documents and tools for troubleshooting and resolving technical issues with Cisco
products and technologies. The website is available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website
requires a Cisco.com user ID and password. If you have a valid service contract
but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Use the Cisco Product Identification (CPI) tool to locate your product serial
number before submitting a web or phone request for service. You can access the
CPI tool from the Cisco Technical Support & Documentation website by clicking
the Tools & Resources link under Documentation & Tools. Choose Cisco
Product Identification Tool from the Alphabetical Index drop-down list, or click
the Cisco Product Identification Tool link under Alerts & RMAs. The CPI tool
offers three search options: by product ID or model name; by tree view; or for
certain products, by copying and pasting show command output. Search results
show an illustration of your product with the serial number label location
highlighted. Locate the serial number label on your product and record the
information before placing a service call.

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4
service requests. (S3 and S4 service requests are those in which your network is
minimally impaired or for which you require product information.) After you
describe your situation, the TAC Service Request Tool provides recommended

[ oL-11600-01
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solutions. If your issue is not resolved using the recommended resources, your
service request is assigned to a Cisco engineer. The TAC Service Request Tool is
located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the
Cisco TAC by telephone. (S1 or S2 service requests are those in which your
production network is down or severely degraded.) Cisco engineers are assigned
immediately to S1 and S2 service requests to help keep your business operations
running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has
established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your
business operations. You and Cisco will commit all necessary resources around
the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or
significant aspects of your business operation are negatively affected by
inadequate performance of Cisco products. You and Cisco will commit full-time
resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most
business operations remain functional. You and Cisco will commit resources
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product
capabilities, installation, or configuration. There is little or no effect on your
business operations.

Installation Guide for Cisco Configuration Assurance Solution
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Obtaining Additional Publications and

Information

Information about Cisco products, technologies, and network solutions is
available from various online and printed sources.

Cisco Marketplace provides a variety of Cisco books, reference guides,
documentation, and logo merchandise. Visit Cisco Marketplace, the company
store, at this URL:

http://www.cisco.com/go/marketplace/

Cisco Press publishes a wide range of general networking, training and
certification titles. Both new and experienced users will benefit from these
publications. For current Cisco Press titles and other information, go to Cisco
Press at this URL:

http://www.ciscopress.com

Packet magazine is the Cisco Systems technical user magazine for
maximizing Internet and networking investments. Each quarter, Packet
delivers coverage of the latest industry trends, technology breakthroughs, and
Cisco products and solutions, as well as network deployment and
troubleshooting tips, configuration examples, customer case studies,
certification and training information, and links to scores of in-depth online
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

iQ Magazine is the quarterly publication from Cisco Systems designed to
help growing companies learn how they can use technology to increase
revenue, streamline their business, and expand services. The publication
identifies the challenges facing these companies and the technologies to help
solve them, using real-world case studies and business strategies to help
readers make sound technology investment decisions. You can access iQ
Magazine at this URL:

http://www.cisco.com/go/igmagazine
or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoig/sample/
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Installation Guide for Cisco Configuration Assurance Solution


http://www.cisco.com/go/marketplace/
http://www.ciscopress.com
http://www.cisco.com/packet
http://www.cisco.com/go/iqmagazine
http://ciscoiq.texterity.com/ciscoiq/sample/

Preface |

[ | Obtaining Additional Publications and Information

o Internet Protocol Journal is a quarterly journal published by Cisco Systems
for engineering professionals involved in designing, developing, and
operating public and private internets and intranets. You can access the
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

» Networking products offered by Cisco Systems, as well as customer support
services, can be obtained at this URL:

http://www.cisco.com/en/US/products/index.html

» Networking Professionals Connection is an interactive website for
networking professionals to share questions, suggestions, and information
about networking products and technologies with Cisco experts and other
networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

*  World-class networking training is available from Cisco. You can view
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
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CHAPTER

Planning Your Installation

Cisco Configuration Assurance Solution is a combination of integrated software
programs:

e Cisco Audit and Analysis—Performs systematic configuration audits of
enterprise-class networks, analyzing an up-to-date model of the production
network to diagnose device misconfigurations, policy violations,
inefficiencies, and security gaps. Hundreds of standard checks incorporate
industry best practices. Users are notified about critical issues and
comprehensive results are published to an integrated web-based report server.

» Cisco Report Server—Provides a web-based central repository for reports
produced by the Cisco Audit and Analysis engine.

» Cisco Virtual Network Data Server—Enables the creation of a high-fidelity
network model based on configuration, topology, and traffic information.

The Cisco Configuration Assurance Solution package contains multiple
installation CDs for the software, models, documentation, and other components
of this solution.

Installation Workflows

There are several possible workflows for installing Cisco CAS, depending on
your situation:

» First-Time Installation, page 1-2—use this workflow to install Cisco CAS for
the first time.

Installation Guide for Cisco Configuration Assurance Solution
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[ | Installation Workflows

« Update Installation (Windows Only), page 1-3—use this workflow to update
a previous version of Cisco CAS to the current version.

First-Time Installation

You should perform a first-time installation only if no prior version of Cisco CAS
is installed.

S

Note  Cisco recommends that you do the steps in the order listed in Table 1-1.

Table 1-1 First-Time Installation: Workflow

Description Reference

Step 1 Register your Cisco Solution Registering Your Cisco Solution Product, page 1-5
product

Step 2 Determine the host computers Determining Installation Options, page 1-6

Step 3 Determine the licensing options Product Licensing, page 1-7

Step 4 Verify system requirements Cisco Audit and Analysis: System Requirements,
page 2-2

Cisco Virtual Network Data Server: System
Requirements, page 3-1

Cisco Report Server: System Requirements, page 2-3

Step 5 Install Cisco Audit and Analysis | Windows:

+ Installing Cisco Audit and Analysis (Windows),
page 4-1

Linux:
+ Installing Cisco Audit and Analysis (Linux), page 4-3

» Setting Up Cisco Audit and Analysis to Run
Automation Tasks (Linux), page 4-5

Installation Guide for Cisco Configuration Assurance Solution
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Installation Workflows

Table 1-1 First-Time Installation: Workflow (continued)

Description

Reference

Step 6 Install Cisco VNDS

Installing Cisco Virtual Network Data Server (Windows),
page 5-1

Installing Cisco Virtual Network Data Server (Linux),
page 6-1

Step 7 Install Cisco Report Server

Installing Cisco Report Server (Windows), page 7-1
Installing Cisco Report Server (Linux), page 7-3

Step 8 Add licenses for:
» Cisco Audit and Analysis
e Cisco VNDS

» Additional product modules
(if any)!

Adding a License, page 9-3

Step 9 Configure node pack licenses (if
any)

Configuring Node Pack Licenses and Notifications,
page 9-6

Step 10 Update the Product Options list for
additional product modules (if
any)

Adding a Module to the Product Options List, page 9-7

1. If you have licenses for any additional product modules, you must add these licenses and add the modules to your

Product Modules list.

Update Installation (Windows Only)

You should perform an update installation if you already have a previous version
of Cisco CAS installed.

Release 2.0 is backward-compatible with earlier releases. Most data from your
existing installation can be migrated transparently to release 2.0, including:

* Network models

* Automation tasks

Cisco Report Server reports can be migrated by using a single menu operation.

Installation Guide for Cisco Configuration Assurance Solution
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A

Warning When updating from an earlier Cisco Virtual Network Data Server release,
you must configure the Oracle database by running the setup_accounts
script (@setup accounts.sqgl). This means that you must re-create the
network database. Network models created by previous releases cannot be
retained by this release.

~

Note  Cisco recommends that you perform the steps in the order listed in Table 1-2.

Table 1-2 Update Installation: Workflow

Description Reference

Step 1 Verify system requirements Cisco Audit and Analysis: System Requirements, page 2-2

Cisco Virtual Network Data Server: System
Requirements, page 3-1

Cisco Report Server: System Requirements, page 2-3

Step 2 Install current release of Windows:
Cisco Audit and Analysis e Installing Cisco Audit and Analysis (Windows),
page 4-1
Linux:
« Installing Cisco Audit and Analysis (Linux), page 4-3

e Setting Up Cisco Audit and Analysis to Run
Automation Tasks (Linux), page 4-5

Step 3 Install current release of Installing Cisco Virtual Network Data Server (Windows),
Cisco VNDS page 5-1
Installing Cisco Virtual Network Data Server (Linux),
page 6-1
Step 4 Install current release of Installing Cisco Report Server (Windows), page 7-1

Cisco Report Server Installing Cisco Report Server (Linux), page 7-3

Step 5 Refresh licenses Upgrading a License, page 9-4

Step 6 Configure node pack licenses (if |Configuring Node Pack Licenses and Notifications,
any) page 9-6

Installation Guide for Cisco Configuration Assurance Solution
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Registering Your Cisco Solution Product Il

Table 1-2 Update Installation: Workflow (continued)
Description Reference
Step 7 (Optional) Migrate existing Migrating Data from a Previous Installation, page 7-5
Cisco Report Server reports
Step 8 (optional) Remove previous Uninstalling Cisco Audit and Analysis (Windows),
release of page 10-1
Cisco Audit and Analysis Uninstalling Cisco Audit and Analysis (Linux), page 10-5
Step 9 (optional) Remove previous Uninstalling Cisco VNDS (Windows), page 11-3
release of Cisco VNDS Uninstalling Cisco VNDS (Linux), page 11-8
Step 10 (optional) Remove previous Uninstalling Cisco Report Server (Windows), page 12-1
release of Cisco Report Server

Registering Your Cisco Solution Product

Note

Before you can install Cisco CAS, you must register your product with Cisco
Systems, Inc. After you register your product, Cisco will send you a username,
password, and group ID number. You will need this information when you install
your product licenses (as described in the “Adding a License” section on

page 9-3.)

By accessing or using the Cisco Systems, Inc. products in this package, you agree
that your use of such products is governed by the terms and conditions of the
Cisco Systems, Inc. Software License and any applicable supplemental license
agreement.

To review the terms of the Software License before accessing or using the
products, you can find a copy of the Cisco Software License in the Cisco
Information Packet that accompanies the products below or online at:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/cetrans.htm

To obtain the license activation credentials, log on to one of the websites listed
below and follow the registration instructions. The Product Authorization Key
(PAK) attached to your Software License Claim Certificate is required for the
registration process. After registering, retain your Claim Certificate for future
reference.
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Registration Information

Use this URL if you are a registered user of Cisco.com:
http://www.cisco.com/go/license

Use this URL if you are not a registered user of Cisco.com:
http://www.cisco.com/go/license/public

You should receive the activation credentials and additional installation
instructions through e-mail within one hour of registration. If you experience
problems with the registration websites or if you have additional questions,
contact the Cisco Licensing department through e-mail at licensing @cisco.com,
or open a service request over the telephone by using one of these numbers:

e Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
« EMEA: +322 704 5555
« USA: 1800 553-2447
You can find a complete list of Cisco TAC contacts at this URL:

http://www.cisco.com/techsupport/contacts

Determining Installation Options

Cisco CAS includes three component programs:
» Cisco Audit and Analysis
e Cisco Report Server

* Cisco Virtual Network Data Server
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Before installing the component programs, select the computers where you want
to install these programs. Each computer must meet the system requirements for
the program of interest, as described in the System Requirements for

Cisco Audit and Analysis chapter.

Product Licensing

Both Cisco Audit and Analysis and Cisco Virtual Network Data Server require a
corresponding license to be installed and available. On startup, the program
contacts a License Server and requests a license. The License Server is a
daemon/process that runs on the host where a license is installed; it handles
license requests from component programs.

Selecting the License Type

When you install a component program, the installer asks you to specify the
licensing mode. The options are:

Floating/Local (“Floating: serve licenses from this computer”)—If you select
this option, the program will request a license from a License Server running
on the local computer.

Floating/Remote (“Floating: access licenses from remote server”)—If you
select this option, the program will request a license from a License Server
running on a remote computer. (The installer also prompts you for the
hostname of the remote server.)

Floating mode enables multiple users to share a license. The following
section describes Floating mode in more detail.

Standalone—If you select this option, the installed license is restricted to the
local computer and the program can be run on that computer only. (In

essence, the program acts as its own License Server.) Select this option only
if you want to restrict the use of Cisco Audit and Analysis to one computer.

A

Note  Cisco Virtual Network Data Server does not support Standalone
licensing.

[ oL-11600-01
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Floating Mode

Floating mode enables users to use the same license on different hosts. On startup,
the program communicates with the License Server automatically and “checks
out” a license. When the program closes, it returns the license to the License
Server. Then the license is available for another user to start the program and
check out the license. In Floating mode, the license is not “node-locked,” but can
“float” to different computers.

Note  Multiple users cannot share the same license concurrently. Multiple concurrent
sessions require an equivalent number of program licenses.

Although the License Server(s) for Cisco Virtual Network Data Server must use
Floating mode, these licenses are not shared among multiple users. Each program
runs automatically and “consumes” its license continually. System administrators
do not need a license to log in to and operate these programs.

Note the following requirements:

*  You must add the corresponding license as described in the “Adding a
License” section on page 9-3. Installing a program and specifying the
licensing options does not install the license itself.

« If you specify Floating (remote) licensing for a program, the specified
License Server must be accessible (via a TCP/IP network) to that program.

* You must use Floating mode for Cisco Audit and Analysis if
Cisco Virtual Network Data Server is also running on the same host. (Note,
however, that Cisco does not recommend running these programs on the same
host.)

Node Pack Licensing

Cisco Audit and Analysis uses a node pack licensing system that determines the
size of the network you can create and analyze. The number of nodes in a network
determines the node pack licenses required to perform an analysis.

Installation Guide for Cisco Configuration Assurance Solution
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You can purchase two different types of licenses for the
Cisco Configuration Assurance Solution product:

e Cisco CAS 2.0 (50 nodes without Cisco VNDS)
e Cisco CAS 2.0 (100 nodes with Cisco VNDS)

If your network has more nodes than are specified in the product license, you must
purchase additional node pack licenses. Node pack licenses are available with
different values (300, 500, 1000, and so on). You must register any additional
node pack licenses before you can create network models and run analyses.

You can combine multiple licenses to satisfy your requirements. For example, any
of the following license combinations will enable you to analyze a 1000-node
network:

* One 1000-node pack license
« Two 500-node pack licenses

* One 500-node pack license and two 300-node pack licenses

Node pack licenses are available for Cisco CAS 2.0 (100 nodes with

Cisco VNDS) only. If you have Cisco CAS 2.0 (50 nodes without Cisco VNDS)
and want to model networks with more than 50 nodes, you must upgrade to
Cisco CAS 2.0 (100 nodes with Cisco VNDS).
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Licensing Scenarios: Examples

This section shows some examples of how you can install and configure licenses
in your network.

In Table 1-3, all licenses are installed on one host (VNDS_client), which acts as
the only License Server in the network. The local Cisco VNDS program uses
Floating/Local mode, while the remote programs use Floating/Remote mode. This
type of setup is recommended; because there is only one License Server, it is
easier to manage your licenses and configure programs.

Table 1-3

Licensing Example 1

LICENSING OPTION
SETTINGS FOR

INSTALLED
LOCAL HOST CONFIGURATION PROGRAM
Licenses Installed on License License
Installed Program Host Name Host Server Mode
Cisco Audit and Analysis AA_client_1 — VNDS_client |Floating /
Remote
Cisco Audit and Analysis AA_client_2 — VNDS_client |Floating /
Remote
Cisco VNDS VNDS_client |Cisco VNDS (local host) Floating /
(License Cisco Audit and Analysis Local
Server)
Installation Guide for Cisco Configuration Assurance Solution
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In Table 1-4, the Cisco Audit and Analysis program is installed on AA_client_1
and two other hosts. Each installation requests a license from AA_client_1. (Keep
in mind that if only one license is installed on the host, only one

Cisco Audit and Analysis session can run at a time.) The two other programs are
installed on separate hosts which also act as License Servers.

Table 1-4 Licensing Example 2
LICENSING OPTION
SETTINGS FOR
INSTALLED
LOCAL HOST CONFIGURATION PROGRAM
License License
Installed Program Host Name Licenses Installed on Host |Server Mode
Cisco Audit and Analysis |AA_client_1 Cisco Audit and Analysis  |(local host) |Floating/
(License Server) Local
Cisco Audit and Analysis |AA_client_2 — AA_client Floating/
Remote
Cisco Audit and Analysis |AA_client_3 — AA_client Floating/
Remote
Cisco VNDS VNDS_client Cisco VNDS (local host) |Floating/
(License Server) Local

Installation Guide for Cisco Configuration Assurance Solution
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In Table 1-5, the programs are installed on separate hosts with their respective
licenses. Cisco Audit and Analysis uses Standalone mode, while Cisco VNDS
request licenses from local License Servers.

Table 1-5 Licensing Example 3
LICENSING OPTION
SETTINGS FOR
INSTALLED
LOCAL HOST CONFIGURATION PROGRAM
License License
Installed Program Host Name Licenses Installed on Host |Server Mode
Cisco Audit and Analysis AA_client_1 Cisco Audit and Analysis (local Standalone
host)
Cisco VNDS VNDS _client Cisco VNDS (local Floating /
(License Server) host) Local

In Table 1-6, each program has its license installed on the same computer and uses
Floating/Local mode.

Table 1-6 Licensing Example 4
LICENSING OPTION
SETTINGS FOR
INSTALLED
LOCAL HOST CONFIGURATION PROGRAM
License License
Installed Program Host Name Licenses Installed on Host |Server Mode
Cisco Audit and Analysis |CAS_client Cisco Audit and Analysis  |(local host)  |Floating
(License Server) / Local
Cisco VNDS Cisco VNDS (local host)  |Floating
/ Local
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System Requirements for
Cisco Audit and Analysis

Cisco recommends that, before you start to install Cisco CAS, you verify that
your computer hardware and software meet the requirements outlined in this
chapter.

Cisco Configuration Assurance Solution:
Operating Environment

An implementation of Cisco CAS consists of the following components:
» Cisco Audit and Analysis
» Cisco Virtual Network Data Server and the back-end Oracle database
e Cisco Report Server

You can install these components on one multi-processor platform (as described
in Single-Platform Implementation, page 2-4) or on multiple platforms.

Installation Guide for Cisco Configuration Assurance Solution
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Cisco Audit and Analysis: System Requirements

Supported Platforms

Vendor! |OS Processor
Microsoft |Windows Server 2003 3.0+ GHz Intel Pentium 4, M, or Xeon
Windows 2000 Server with 800-Mhz front-side bus

Windows 2000 Professional

Red Hat Red Hat Enterprise Linux 3 (v2.4 Linux kernel)2 x86 or EM64T (Intel Pentium III, 4,
Red Hat Enterprise Linux 4 (v2.6 Linux kernel) |Xeon, or compatible, 500 Mhz or
better)

x86 AMD or AMD64, 500 MHz or
better

1. Cisco Audit and Analysis is supported on the English-language version of each operating system.

2. libstdc++.50.6 is required with Red Hat Enterprise Linux 3. You can obtain this by installing gcc 3.4 or higher.

Required Patches

Vendor oS Patch Number/Name
Microsoft |Windows Server 2003 N/A
Windows 2000 Server Service Pack 1, 2, and 4 are

supported, but not required

Windows 2000 Professional Service Pack 1, 2, and 4 are
supported, but not required

To determine the service pack installed on your Windows system, run winver.exe:

Stepl  Select Run from the Windows Start menu.

Installation Guide for Cisco Configuration Assurance Solution
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Cisco Report Server: System Requirements Il

Step2  Type in the command winver and click OK. The About Windows window appears
and shows the version and service pack level installed.

Other Requirements

Display Colors: 256 (minimum)
Resolution: 1024x768 (minimum)

Supporting Software |TCP/IP networking software is required.

Web Browser To view web reports generated by Cisco CAS, you must have Firefox 1.0.6 or
higher, Internet Explorer 5.0 or higher, or a compatible browser that supports
Style Sheets.

Cisco Report Server: System Requirements

Supported Platforms

Vendor! 2 |Series Processor

Microsoft Windows 2000 Server intel Pentium III, 4 or
Windows 2000 Professional compatible

(500 MHz or better)
Windows XP Professional
Windows Server 2003

1. Cisco Report Server is supported on the English-language version of Windows only.

2. Cisco Report Server is not supported on 64-bit editions of Windows operating systems.

Installation Guide for Cisco Configuration Assurance Solution
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Required System Patches

Vendor (OF] Patch Number/Name
Microsoft Windows 2000 Professional Service Packs 1, 2, and 4 are supported but not
required.
Windows XP Professional Service Pack 1 is required; Service Pack 2 is
supported but not required.

Windows System Configuration

RAM

System and Working File
Space!

512MB (minimum)
1GB (recommended)

80GB (minimum)
20GB (recommended)

1. Disk space requirements are highly dependent on the volume of
report information stored on the report server and aging and report

deletion policies.

Browser Requirements

To view Cisco Report Server reports, you must use Internet Explorer 6.x or a
compatible browser that supports Style Sheets.

Single-Platform Implementation

A single multi-processor platform might not deliver performance comparable to
multiple platforms with equivalent total processors due to differences in the
maximum front-side bus speed. However, if all components are to be installed on
a single platform, the requirements are as follows.
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Single-Platform Implementation

RAM Free Disk Space Processor

7+ GB 200 GB 4-way 3.0+ GHz Intel Xeon or Pentium 4
with 800-MHz front-side bus

Installation Guide for Cisco Configuration Assurance Solution
[ oL-11600-01 .m



Chapter 2 System Requirements for Cisco Audit and Analysis |

[ | Single-Platform Implementation

Installation Guide for Cisco Configuration Assurance Solution
m. OL-11600-01 |




CHAPTER 3

System Requirements for
Cisco VNDS

This chapter describes the system requirements for the individual components in
Cisco Virtual Network Data Server. Cisco recommends that, before you start to
install Cisco CAS, you verify that your computer hardware and software meet the
requirements outlined in this chapter.

Cisco Virtual Network Data Server: System
Requirements

Supported Platforms

Vendor!?  |Series

Microsoft  |Windows 2000 Server
Windows 2000 Professional
Windows XP Professional
Windows Server 2003

Red Hat Red Hat Enterprise Linux 3 (v2.4 Kernel)?
Red Hat Enterprise Linux 4 (v2.6 Kernel)

Installation Guide for Cisco Configuration Assurance Solution
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Cisco VNDS is supported on the English-language version of each operating system.

2. Cisco VNDS is not supported on 64-bit editions of Windows or Linux operating systems, nor on
Windows 2003 Web Edition.

3. libstdc++.50.6 is required with Red Hat Enterprise Linux 3. You can obtain this by installing gcc
3.4 or higher.

Required System Patches

Vendor oS Patch Number/Name
Microsoft |Windows 2000 Server Service Pack 2 minimum
Windows 2000 Professional Service Pack 2 minimum
Windows XP Professional N/A
Windows Server 2003 N/A

To determine the service pack installed on your Windows system, run

winver.exe:

Stepl  Select Run from the Windows Start menu.

Step2  Type in the command winver and click OK. The About Windows window appears
and shows the version and service pack level installed.
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Cisco Virtual Network Data Server: System Requirements

Windows and Red Hat System Configuration

Cisco VNDS does not operate on machines with the Intel Itanium processor. To
check the processor used by your Windows computer, right-click on the My
Computer desktop icon and choose Properties.

Processor? RAM? |Disk  |FSB?®

Intel Pentium D processor model 945 4GB |80 GB |800 MHz
2x2MB Cache, 3.4 GHz

Dual Processor, Dual Core Intel Xeon Model 5060, (4 GB 80 GB 1066 MHz
Minimum 2x2MB Cache,3.2 GHz

Intel Core2 Duo Processor Model E6700, 4MB 6 GB |80GB 1066 MHz
Cache - 2.66GHz

Dual Processor, Dual Core Intel Xeon Model 5160, |6 GB |160GB |1333 MHz
Recommended |4MB Cache - 3.0 GHz

1. A dual-processor configuration is recommended if Cisco VNDS and the back-end Oracle database are to reside on the same
platform.

2. Cisco VNDS performance will improve with more available memory as network size increases.

3. Front-Side Bus (FSB) speed affects the speed of data transfer to and from the Cisco VNDS database; faster bus speeds will
improve Cisco VNDS performance.

Other Requirements

Cisco VNDS requires a dedicated Oracle database installation and dedicated
database instance that cannot be shared with other applications. The preferred
configuration includes a dedicated Oracle database installation local to the system
on which Cisco VNDS is installed.

A shared Oracle instance where applications other than Cisco VNDS share/access
the database or database instance are NOT supported. An Oracle database that is
running on a system physically remote from or on a separate LAN from the
Cisco VNDS system is NOT supported.

Installation Guide for Cisco Configuration Assurance Solution
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Required Database

Software! Platform | Supported Version Character Set?
Oracle Database Windows | ¢ Oracle 9i Release 2 (version 9.2.0.1 or WESMSWIN1252
higher)
» Oracle 10g Release 2 (version 10.2.0.1 or
higher)
Red Hat * Oracle 9i Release 2 (version 9.2.0.1 or WESISO8859P1
higher) or

¢ Oracle 10g Release 2 (version 10.2.0.1 or
higher)

1. Contact Oracle Corporation for information about Oracle 9i system requirements.

2. The supported national character set is: ALI6GUTF16. For international customers: The Virtual Network Data Server 4.0
product might not operate correctly when used with Oracle databases that have been configured with international, or Unicode
(AL32UTFS8), database character sets.
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Installing Cisco Audit and Analysis

This chapter contains the following procedures:
e Installing Cisco Audit and Analysis (Windows), page 4-1
» Installing Cisco Audit and Analysis (Linux), page 4-3

» Setting Up Cisco Audit and Analysis to Run Automation Tasks (Linux),
page 4-5

Installing Cisco Audit and Analysis (Windows)
N

Note  Before you install Cisco Audit and Analysis, verify that you have a supported
version of Windows installed as well as any required system patches. For more
information, see Cisco Audit and Analysis: System Requirements, page 2-2.

Use the following procedure to install Cisco Audit and Analysis.

Installing Cisco Audit and Analysis on Windows

Stepl Log in as Administrator.
Step2  Insert the Cisco CAS, Audit and Analysis CD into your CD-ROM drive.

The installation program should start automatically. If it does not, double-click on
the icon that represents the CD-ROM and click on the setup.exe icon.

Installation Guide for Cisco Configuration Assurance Solution
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~

Note  If you are installing on Windows XP, you might see an error window that
reads, “OPNET <product_name>has encountered a problem and needs to
close.” This error occurs because the installer caused an existing License
Server process (op_license_server.exe) to terminate abnormally. This is a
known issue; simply click Don’t Send and proceed with the installation.

You will be prompted for a directory in which to install your software (typically
C:\Program Files\Cisco\CiscoCAS2.0).

Step3  The software installer prompts you to specify the Cisco Report Server hostname
and port.

If you have not yet installed Cisco Report Server, write down the port number
because you will need this when you install the Cisco Report Server software (as
described in Chapter 7, “Installing Cisco Report Server.”).

If you have already installed Cisco Report Server, enter its host and port number
now.

Step4  When the software installer prompts you to specify the type of licensing system
to install, the following might help you decide:

» Standalone is recommended if you are the only Cisco Audit and Analysis
user.

o Floating: access licenses from remote server is the correct choice if you
already have a license server running on a remote machine and you want this
installation to get its licenses from that machine.

e Floating: serve licenses from this computer is the correct choice if the current
machine will be the license server.

Note  If there is an existing installation of Cisco Audit and Analysis on this computer,
you can check how that release was licensed by running its License Manager. The
first line of the license servers tree describes the licensing.

For more information about these options, see the “Product Licensing” section on
page 1-7.

Step 5 Insert the Cisco CAS, Models CD into your CD-ROM drive.

The installation program should start automatically. If it does not, double-click on
the icon that represents the CD-ROM and click on the setup.exe icon.
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Step 6

Installing Cisco Audit and Analysis (Linux) W

Insert the Cisco CAS, Documentation CD into your CD-ROM drive.

The installation program should start automatically. If it does not, double-click on
the icon that represents the CD-ROM and click on the setup.exe icon.

S

Note  Installing does not install the license for this program. Before you can run
the program, you must add the license as described in the Managing
Licenses chapter.

Cisco Audit and Analysis is now installed. Return to the installation workflow
and continue with the next step.

Installing Cisco Audit and Analysis (Linux)

N

Note

Before you install Cisco Audit and Analysis, verify that you have a supported
version of Linux installed as well as any required system patches. For more
information, see Cisco Audit and Analysis: System Requirements, page 2-2.

Use the following procedure to install Cisco Audit and Analysis.

Installing Cisco Audit and Analysis (Linux)

Step 1
Step 2

Step 3
Step 4

Step 5

Log in as root.

If you plan to use the Report Server, install it now. (See the Report Server
Installation Instructions that come with the Report Server install package.)

Insert Cisco CAS, Audit and Analysis CD in your CD-ROM drive.
Move to the unix directory on the CD, as follows:

mount /media/cdrom

cd /media/cdrom

cd unix

Enter the command . /op_install.

[ oL-11600-01
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Step6  When you are prompted to specify the type of licensing system to install, the
following might help you decide:

e Standalone is recommended if you are the only Cisco Audit and Analysis
user.

o Floating -- access licenses from remote server is the correct choice if you
already have a license server running on a remote machine and you want this
installation to get its licenses from that machine.

e Floating -- serve licenses from this computer is the correct choice if the
current machine will be the license server.

Step7 At the end of the installation script for the Core software CD, the installer shows
the following instruction: “To complete the installation process, follow these
steps”. Note this information for use when configuring user accounts.

Step 8  When you see the prompt “End of installation script”, change directories to / tmp
to allow the CD to be ejected.

Step9  Eject the CD with the eject command.

Step 10 Insert the Cisco CAS, Models CD into your CD-ROM drive and run the installer
as described previously.

Step 11  Insert the Cisco CAS, Documentation CD into your CD-ROM drive and run the
installer as described previously.

Cisco Audit and Analysis is now installed. Return to the installation workflow
and continue with the next step.

N

Note  These installers do not install the license for this program. Before you can
run the program, you must add the license as described in the Managing
Licenses chapter.

N

Note  These installers do not automatically detect the default web browser you
have installed on your Linux system. Search the known product issues (as
described in Appendix D, “Known Issues”) for details on how to
configure Cisco Audit and Analysis to use your preferred web browser.
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Setting Up Cisco Audit and Analysis to Run Automation Tasks (Linux)

Setting Up Cisco Audit and Analysis to Run
Automation Tasks (Linux)

When running on Linux, Cisco Audit and Analysis requires an X display to run
an automation task. If the task is launched while a user is logged on to the Linux
host, Cisco Audit and Analysis can use the X display of that user. If no one is
logged on, however, Cisco Audit and Analysis does not have access to a user
display.

To run automation tasks even when no one is logged on, you must install and
configure a virtual frame buffer on the host. To do this, perform the following
procedures:

1. Installing a Virtual Frame Buffer on the Linux Host, page 4-5

2. Configuring Cisco Audit and Analysis to use the Virtual Buffer Display,
page 4-6

Installing a Virtual Frame Buffer on the Linux Host

Step1  Download and install the xvfb software package. Using Red Hat distributions, the
package name is usually "xvfb" and can be installed through the distribution's
package manager. It may also be obtained from http://www.xfree86.org Or
http://www.x.org. You should download the version of xvfb that corresponds to
your existing X server.

Step2  Choose a screen that will be dedicated to xveb. (NOTE—The following steps
assume that screen 1 is chosen.)

Step3  Create the file /etc/init.d/xvEb (with root execution permissions) that contains
the following text:

#!/bin/sh
mode=$1
case "Smode" in
'start"')
# start the X Virtual Framebuffer (Xvfb)
if [ -f /usr/X11R6/bin/Xvfb ]; then
echo "***Starting up the Virtual Frame Buffer on Screen 1***x"
/usr/X11R6/bin/Xvfb :1 -screen 0 1152x900x8 &
Installation Guide for Cisco Configuration Assurance Solution
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Step 4

Step 5

echo " Usage: "
echo " $0 start (start XVFB)"
echo " $0 stop (stop XVFB - not supported)"

Create a soft link to a file in the appropriate run-level directory. For example, to
make xv£b execute at run level 5, run the following command:

ln -s /etc/init.d/xvfb /etc/rc5.d/S75xvfb

Reboot the Linux system.

Configuring Cisco Audit and Analysis to use the Virtual Buffer Display

Step 1

Step 2
Step 3
Step 4
Step 5

Step 6

If you have not already done so, perform Installing a Virtual Frame Buffer on the
Linux Host, page 4-5.

Start Cisco Audit and Analysis.
Select Automation > Configure/Run Automation Tasks.
Click the "Display Settings..." button.

Enter the display name for xv£b. For example, if your host name is
“my_local_host” and xv£b is running on screen 1, you would enter the following
string:

my local host:1

Click OK in the Display Settings dialog box, then click OK in the Configure/Run
Automation Tasks dialog box.

From this point forward, Sentinel will send its windows to xvfb. To view the
"screen" at any time, you can run the following command:

xwd -display :1 -root -out image.xwd

To view the image dump, run the following command:
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xwud -in image.xwd
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Installing
Cisco Virtual Network Data Server

(Windows)

This chapter describes how to install the Cisco Virtual Network Data Server
program on Windows.

System Requirements

~

Note

The host for Cisco Virtual Network Data Server must meet minimum system
requirements. If the host system does not meet minimum requirements, do not
install Cisco VNDS. For more information, see

Cisco Virtual Network Data Server: System Requirements, page 3-1.

If the host system does not have an Oracle database or an Oracle client
installation, but meets all other requirements, install Oracle before installing
Cisco Virtual Network Data Server as described in the Installation Workflows for
your installation scenario.
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Installation Workflows

Note

This section covers the various installation scenarios you may encounter with
Cisco VNDS on Windows. The procedures you must follow depend upon whether
this is an initial installation or an update to an existing installation of the

Cisco Virtual Network Data Server program. The procedures to follow also
depend upon whether Cisco VNDS uses a local (same host) or a remote (different
host) database.

Select the installation workflow appropriate for your circumstances. Follow the
procedures in your workflow to install Cisco Virtual Network Data Server.

» Initial Cisco VNDS Installation (Windows/Local Oracle Database), page 5-2

o Initial Cisco VNDS Installation (Windows/Remote Oracle Database),
page 5-3

e Update Cisco VNDS Installation (Windows), page 5-5

Cisco VNDS software is installed in HTTP mode by default. After successful
installation and verification of the Cisco Virtual Network Data Server software,
HTTPS may be configured. See the HTTPS Mode section of Release Notes for
more information.

Initial Cisco VNDS Installation (Windows/Local Oracle

Database)

Step 1

Step 2

If you are installing Cisco Virtual Network Data Server for the first time and will
install Oracle on the same host, follow this workflow:

Install the Oracle database on the Cisco VNDS host.
* Oracle9i users: see Installing the Oracle9i Database (Windows), page A-1.

e Oraclel0g users: see Installing the Oracle10g Database (Windows),
page A-7.

Collect Oracle database information.

See the “Collecting Oracle Database Access Information (Windows)” procedure
on page A-13.
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Step 3

Step 4

Step 5

Step 6

Step 7

Installation Workflows

Install Oracle TopLink.
See the “Installing Oracle TopLink (Windows)” procedure on page A-14.

S

Note  You must complete the previous steps before you install Virtual Network
Data Server.

Install the Cisco Virtual Network Data Server program.
See the “Installing Cisco VNDS (Windows)” procedure on page 5-6.
Configure the Oracle database.

See the “Configuring the Oracle Database for Cisco VNDS (Windows)”
procedure on page 5-17.

Verify the Oracle configuration.

See the “Verifying the Oracle Configuration for Cisco VNDS (Windows)”
procedure on page 5-21).

Verify the Cisco VNDS software installation.

See the “Verifying the VNDS Software Installation (Windows)” procedure on
page 5-23.

Initial Cisco VNDS Installation (Windows/Remote Oracle
Database)

If you are installing Cisco Virtual Network Data Server for the first time and will
install Oracle on a different host, follow this workflow:

Step1l  Install the Oracle database on the remote host.
For information about installing the Oracle database, see Appendix A, “Oracle
Procedures (Windows)” or Appendix B, “Oracle Procedures (Linux)”.
Step2  Install the Oracle client on the Cisco VNDS host.
Installation Guide for Cisco Configuration Assurance Solution
| oL-11600-01 .m



Chapter 5 Installing Cisco Virtual Network Data Server (Windows) |

[ | Installation Workflows

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

~

Note  Install the version of the client that matches the version of the database
that you installed in step 1.

* Oracle9i users: see Installing the Oracle9i Client (Windows), page A-5.
e Oraclel0Og users: see Installing the Oracle 10g Client (Windows), page A-10.

Collect Oracle database information (use the procedure for the platform on which
the remote database is installed):

*  “Collecting Oracle Database Access Information (Windows)” procedure on
page A-13

»  “Collecting Oracle Database Access Information (Linux)” procedure on
page B-3

Install Oracle TopLink.
See the “Installing Oracle TopLink (Windows)” procedure on page A-14.

N

Note  You must complete the previous steps before you install Virtual Network
Data Server.

Install the Cisco Virtual Network Data Server program.
See the “Installing Cisco VNDS (Windows)” procedure on page 5-6.
Configure the Oracle database on the database host.

See the “Configuring the Oracle Database for Cisco VNDS (Windows)”
procedure on page 5-17.

Verify the Oracle configuration on the Cisco VNDS host.

See the “Verifying the Oracle Configuration for Cisco VNDS (Windows)”
procedure on page 5-21.

Verify the Cisco VNDS software installation.

See the “Verifying the VNDS Software Installation (Windows)” procedure on
page 5-23.

Installation Guide for Cisco Configuration Assurance Solution
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Update Cisco VNDS Installation (Windows)

A

Warning

Step 1

Step 2

Step 3

Step 4

Step 5

If you are updating a previous Cisco Virtual Network Data Server program
installation, follow this workflow.

When updating from an earlier Cisco Virtual Network Data Server release,
you must configure the Oracle database by running the setup_accounts
script (@setup_accounts.sql). This means that you must re-create the
network database. Network models created by previous releases cannot be
retained by this release.

Collect Oracle database information.

See the “Collecting Oracle Database Access Information (Windows)” procedure
on page A-13.

N

Note  You must complete this step before you install Virtual Network Data
Server.

Install the Cisco Virtual Network Data Server program.
See the “Installing Cisco VNDS (Windows)” procedure on page 5-6.
Configure the Oracle database on the database host.

See the “Configuring the Oracle Database for Cisco VNDS (Windows)”
procedure on page 5-17.

Verify the Oracle configuration on the Cisco VNDS host.

See the “Verifying the Oracle Configuration for Cisco VNDS (Windows)”
procedure on page 5-21.

Verify the Cisco VNDS software installation.

See the “Verifying the VNDS Software Installation (Windows)” procedure on
page 5-23.
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Installation Guide for Cisco Configuration Assurance Solution



Chapter 5 Installing Cisco Virtual Network Data Server (Windows) |

[ | Installing Cisco VNDS (Windows)

~

Note ~ When updating from a previous Cisco VNDS installation, you can
migrate configuration settings. Do not uninstall the previous installation
until you migrate product configuration settings to the new installation.
Make sure you read important notes on product migration in the Release
Notes.

Installing Cisco VNDS (Windows)

Use the following procedure to install the Cisco Virtual Network Data Server
program.

Installing Cisco VNDS (Windows)

Step1  Log into the host as Administrator or as a user with full administrative privileges.
If you are not logged in with the proper privileges, log off and then log on with an
appropriate account.

Step2  If the Cisco VNDS program is already installed on the host and you are updating
to a new release, perform the following steps before continuing.

a. Stop Cisco VNDS operation: Select Services > Stop Services from the
Cisco Virtual Network Data Server Control Panel.

b. Exit Cisco VNDS: Select File > Exit from the Control Panel menu bar.

c. Open the Windows Task Manager, and select the Processes tab. If an
op_monitor process is running, stop the process.

d. Use a License Manager to see if your Cisco VNDS license is still held. If the
license is still held by Cisco VNDS, use the License Manager to revoke the
license.

~

Note Do not rename or uninstall the existing Cisco VNDS release. If
Cisco VNDS 3.5 is already installed (as part of CAS, CAS-SP, NPS, or
NPS-SP), you can migrate configuration settings to Cisco VNDS 4.0.

Installation Guide for Cisco Configuration Assurance Solution
m. OL-11600-01 |




| Chapter 5 Installing Cisco Virtual Network Data Server (Windows)

Installing Cisco VNDS (Windows) W

Step3  Start the installer:

a. Insert the Cisco Virtual Network Data Server installation CD into the CD
drive of the host. If the installer does not start automatically, use Start > Run
to execute the cvnds-2.0-win-K9.exe program on the CD.

The installer displays an Introduction panel.
b. Click Next.

If an existing Cisco VNDS software installation is detected, a votice dialog
appears to remind you to stop services and exit Cisco VNDS. Click Yes to
continue or No to cancel the installation.

Step4  Determine your Oracle installation scenario in Table 5-1 on page 5-8 and follow
instructions for that scenario.

~

Note  Cisco VNDS can operate with either a local or remote Oracle database. If
a database is present on the local host, you can use this database; you can
also use a remote database on a different host. In either case, the installer
displays a panel that requests database access information. If a local
database is not found, but an Oracle client installation is detected, the
installer displays a panel requesting access information about the remote
database.

Installation Guide for Cisco Configuration Assurance Solution
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Table 5-1 Oracle Installation Scenarios
Scenario |Oracle Installation Instructions
1 * An Oracle installation is not present on | « Abort installation. Click OK to cancel
the host. the installation.
* A message box indicates that Oracle + Install Oracle on the host before
cannot be found. attempting to install Cisco VNDS.
2 » Oracle database installation is present |An installer panel appears and asks if you
on host. want Cisco VNDS to use the local database.
» If more than one Oracle installation is » Select Yes to use the local database and
found on the host, the installer asks continue with step 5.
Whl,Ch Oracle you want to use. Select the | Select No to use a remote database, and
radio button for the correct Oracle . .
. . . continue with step 6.
installation and click Next.
3 » Oracle client installation is present on « An installer panel appears stating that a

the host.

If more than one Oracle installation is
found on the host, the installer asks you
which Oracle you want to use. Select the
radio button for the correct Oracle
installation and click Next.

local Oracle client is detected!.

« if the Oracle installation is a Client,
select the Client radio button. Click OK
and continue with step 6.

« If the Oracle installation is really a local
database server, select the Server radio
button. Enter the Database SID from
Table A-1 on page A-14. Click OK and
continue with step 5.

1. Depending upon how Oracle is installed and databases are created, what appears to be a Client installation may really be a

Server.

Step 5

~

Note  If you are working with a local database, use step 5. If you are working
with a remote database, use step 6.

database:

Specify values for the account Cisco VNDS will use to access the local Oracle

— Local Database TNS Service Name

— Local Database User Name

J _ !'nstallation Guide for Cisco Configuration Assurance Solution
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— Local Database Password
— Confirm Password
~

Note  Select a user name that is dedicated for use by Cisco VNDS. DO NOT
use SYS or SYSTEM for the Local Database User Name.

Fill in each field with the information collected in Table A-1 on page A-14
and click Next. Jump to step 7.

Step6  Specify remote database access information.
a. The installer prompts you for the following database access information:
— Remote Database TNS Service Name
— Remote Database SID
— Remote Database Hostname
— Remote Oracle Home Directory
— Remote Oracle Oradata Parent Directory

Fill in each field with the information collected in Table A-1 on page A-14
and click Next.

The installer prompts you for additional remote database access information.

b. Specify values for the account Cisco VNDS will use to access the Oracle
database.

— Remote Database User Name
— Remote Database Password
— Confirm Password

~

Note  Select a username that is dedicated for use by Cisco VNDS. DO NOT
use SYS or SYSTEM for the Local Database User Name.

c. Fill in each field with the information collected in Table A-1 on page A-14
and click Next.

Step 7  The installer prompts you for the location of Oracle Toplink files required by
Cisco VNDS.

[ oL-11600-01
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~

Note  Note: Version 9.0.3.5 of Oracle Toplink is required.

a. If you have Toplink installed to the default path within your existing Oracle
installation, the default path shown in this panel is the correct path. Locate
the path on your system that contains the following Toplink files:

tl _core.jar tl _tools.jar tl _x.jar

b. Click Choose and browse to the directory of the required Oracle Toplink files.
Click Select to complete your choice.

Step8  Click Next. If the required files are not found at the selected path, an error dialog
appears. Click one of the following:

* OK to try again to select a path.
» Cancel to cancel the installation.
Step9  Specify the licensing scheme.

a. The installer prompts you for the type of licensing to use. The seiect
Licensing Type panel provides a choice between remote and local licensing:

— Access licenses from a remote server
— Serve licenses from a license server on this computer

A

Note  Selecting the local option results in a license server being installed
with the VNDS installation. This license server installed is the same
version license server as is installed with other Cisco Solution
programs.

N

Note  The specified license server must have a valid VNDS license before
you can run the software.

b. Choose the licensing type, then click Next.

— If you selected remote licensing, the installer displays the Enter Server
Name and Port panel. Proceed to step c.

— Ifyouselected local licensing the Enter Port panel displays. Jump to step
d.

Installation Guide for Cisco Configuration Assurance Solution
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c. The installer prompts you for the server name and port.
— Type the hostname of the remote license server in the Server field.

— Type the port (port_a, port b, or port_c) used by the remote license
server in the Port field.

— Click Next.
The installer prompts you for an installation path. Proceed to step 10.

d. The installer prompts you for the port used by the local license server
(portia, port b, Or portic).

Accept the default value. Click Next to proceed.

The installer prompts you for an installation path. Proceed to step 10.

~

Note  If you are installing on Windows XP, you might see an error window
that reads “OPNET <product_name> has encountered a problem and
needs to close.” This error occurs because the installer caused an
existing license server process (op_license server.exe) to
terminate abnormally. This is a known issue; click Don’t Send and
proceed with the installation.

A

Note  Write down the license settings you have chosen for future reference.

Step 10  Specify the VNDS installation directory.

a. Type an installation path in the panel’s path field or use the file browser to
select an installation path. The path you choose cannot contain embedded
spaces.

N,
Note  The path you enter is the parent directory for the installation. The

installer adds \vNDserver\<version> <build#> to the path you
choose.

b. Click Next.
The installer prompts you for the path to use for the VNDS temp directory.
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Step 11  Specify the VNDS temporary directory.

a. Type a temp directory path in the panel’s pacx field or use the file browser to
select a path. The path you choose cannot contain embedded spaces.

~

Note

The temp directory holds temporary working files for the product.
The path you specify is the full path to this directory.

b. Click Next.

The installer prompts you for the path to use for the VNDS config file archive
directory.

Step 12 Specify the VNDS config file archive directory.

a. Type an archive directory path in the panel’s path field or use the file browser
to select a path. The path you choose cannot contain embedded spaces.

A

Note

The archive directory holds collected device configuration files that

have been archived by the product. The path you specify is the full
path to this directory.

b. Click Next.

The installer prompts you to configure server parameters.
Step 13

Specify server information for this instance of Cisco VNDS. The installer
prompts you for the following information:

— Virtual Network Data Server Name

— Virtual Network Data Server ID (0-1022)

— Virtual Network Data Server Address

a. Type the primary IP address of the host in the

Cisco Configuration Assurance Solution Address field.
&

Note

The primary IP address is required for all VNDS installations. To

obtain the IP address, open a command window and run the ipconfig
command.

J _ !'nstallation Guide for Cisco Configuration Assurance Solution
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b. Fill in additional fields if this instance of Cisco VNDS will participate in an
n-tier hierarchy.

c. Click Next.

The installer displays the configure

Cisco Configuration Assurance Solution Client Connectivity panel.
Step 14  Specify the VNDS Client Connectivity Port.

Type a port number or click Next to accept the default value.

N

Note  The Client Connectivity port is the port on which the Live Update
Service runs. If you enter a non-default port, VNDS clients might be
unable to communicate with Cisco VNDS until you make a
corresponding change in the client preferences.

The installer displays a panel for configuration of the web server.
Step 15  Specify web server connectivity information.
a. The installer prompts you for the following:
— HTTP Port
— HTTPS Port
— Keystore Directory
b. Fill in each field or click Next to accept default values.
The installer prompts you to set the Web Server Administrator password.

S

Note  Write down the web server connectivity settings for future use.

Step 16  Specify the password for the administrator (admin) user account for the
Cisco Configuration Assurance Solution Web Console. The installer prompts you
for the following information:

— Enter administrator password
— Confirm administrator password

Type a password into the password fields or click Next to accept the default
(cisco).
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N

Note  Write down the admin password. You will need this password to log
into the Cisco Virtual Network Data Server Web Console for the first
time—the VNDS Web Server is installed in the local authentication
mode by default. Once logged into the Web Console, the admin user
can change the admin password, create user accounts, or change the
authentication scheme.

The installer prompts you to configure email notification parameters.

Step 17  If you want to begin receiving email notification as soon as you start VNDS
services, configure email notifications at this time. Otherwise, configure
notifications when you are ready to begin automated operation (recommended)
using the Notification panel in the Cisco Virtual Network Data Server
Administrative Console.

a. Enter the sender, recipients, and subject prefix for VNDS email notifications
or leave these fields blank if you want to configure email notifications
post-installation.

b. Click Next to proceed.
The installer prompts you for email server settings.

c. Enter the SMTP Server, Port, User Name, and Password (if you want to
configure email notifications post-installation, leave these fields blank).

d. Click Next to proceed.

An installation progress panel shows status messages as VNDS installation
progresses. Installation normally finishes in several minutes.

— If anexisting VNDS 3.5 installation is detected, the installer displays the
Migrate Cisco Configuration Assurance Solution Product
configuration panel. Proceed to Step 18.

S

Note  The installer checks the version of the Oracle Toplink files that you
chose in Step Step 7. If the wrong version files were selected, an error
dialog box appears. Click OK to continue. Before operating Virtual
Network Data Server, you must locate the correct version of the
required Toplink files and copy them to the <install dir>\ext directory

Installation Guide for Cisco Configuration Assurance Solution
m. OL-11600-01 |




| Chapter 5

Installing Cisco Virtual Network Data Server (Windows)

Installing Cisco VNDS (Windows) W

If you are installing on a host that does not have Cisco VNDS 3.5
software installed, the installer displays the web Services note panel
when installation is complete. Jump to step 19.

Step 18 Migrate the configuration settings from the previous version of
Cisco Virtual Network Data Server to the current version (optional).

To migrate previous settings, perform the following steps:

Select Yes in the Migrate Cisco Configuration Assurance Solution
Product Configuration panel, then click Next.

A Confirm dialog box displays. It provides the path of the previous
installation (from which it will migrate product configuration) and lists
the actions that will be performed if you proceed.

Click Yes to continue with migration. Click No to skip migration and
proceed to step 19.

Progress dialog boxes display during product configuration. A Status
dialog box displays when migration is complete. This dialog summarizes
the actions performed and provides the location of migration logs. Click
OK and proceed to step 19.

~

Note  During migration, VNDS 3.5 device info file is copied to the 4.0
installation. However, it is not converted to the 4.0 format or
imported into Cisco VNDS. See the Release Notes for important
notes on updating.

To install without migrating previous settings, perform the following steps:

Select No in the Migrate Cisco Configuration Assurance Solution
pProduct Configuration panel then click Next.

A Notice dialog displays.

Click OK to proceed to step 19. Click Previous to go back to the vigrate

Cisco Configuration Assurance Solution Product Configuration
panel.
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Step 19

Step 20

Step 21

Note

~

Note  If you chose not to migrate but want to preserve groups, you must
export this information from the database before you configure
the database for 4.0. You can migrate adapter resources and text
files after installation is complete as long as you do not uninstall
or delete files from the previous release installation directory. See
the Administration chapter of the
Cisco Configuration Assurance Solution User Guide for
instructions on how to run the migration tools.

Read the wep services Note.

A}
Note  VNDS software is installed in HTTP mode. You can optionally configure

HTTPS after you have completed your installation workflow. See the
HTTPS Mode section of the Release Notes for more information.

Click Next.
The installer displays the rnstail complete panel.

Click Done to exit the installer.

)

Note  Installation of VNDS software is now complete. Return to the workflow
you are following and continue with the next step. Do not attempt to start
Cisco VNDS or access the Web Console until you complete all steps in
the installation workflow.

Refer to the Cisco Configuration Assurance Solution User Guide, Administration
chapter, Licensing Operations section for instructions on adding a license.

After you have installed VNDS software, see Configuring the Oracle Database for
Cisco VNDS (Windows), page 5-17.
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Configuring the Oracle Database for Cisco VNDS
(Windows)

A

Warning

After you install the current version of Cisco Virtual Network Data Server, you
must configure the Oracle database for use by Cisco VNDS. This involves
running an SQL script named setup accounts.sgl that creates tablespaces for
the database and a VNDS access account.

Do not modify the setup_accounts.sgl script. This can cause the installation
to fail or prevent Cisco Configuration Assurance Solution from operating
correctly.

To configure the Oracle database, perform “Configuring the Oracle Database
(Windows)” section on page 5-17.

Configuring the Oracle Database (Windows)

Step 1

Step 2

Step 3

If the Oracle database and Cisco VNDS are located on the same host system, open
a command window and navigate to the Cisco Virtual Network Data Server
installation directory by typing

cd <install path>\VNDServer\<release number> <build numbers

Stay in the command window on the host system for Cisco VNDS, and continue
with step 2.

Log into Oracle using the system account.
¢ For a local Oracle database installation enter the following command:
sglplus system/<system password>
» For a remote Oracle database, enter the following command:
sglplus system/<system password>@<DB TNS Service Name>

For example, if the Database is remote with a TNS Service Name of 092avnes
and the Oracle system password is magic, type:

sglplus system/magic@o92avnes
Enter the following command at the sor> prompt:

@setup_accounts.sqgl

[ oL-11600-01
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A message banner displays to inform you how much free disk space is required
on the disk that hosts the database.

a~

Note  If you do not have sufficient disk space available to run this script, free up
sufficient disk space before proceeding. If you want to cancel the script,
press Ctrl-C or close the command window.

Step4  Click Enter to continue.
A message banner displays a notification about Device and Platform Info.
» For Oracle9i, proceed to step 5.
» For Oracle10g, jump to step 6.
Step5  Click Enter to continue.

When you configure Oracle 91, a message banner displays with a list of database
parameters, database parameter settings, and whether the parameters meet
recommended settings. A log of database analysis results is saved to

<install dirs>\analyzedb.<timestamp>.log.

~

Note  If all parameters meet recommended settings, no further action is
required. If one or more parameters do not meet recommended settings,
the installer recommends that you run the dbparamchg.sql script after this
procedure is completed; this will improve data import performance with
large networks and increase Oracle memory requirements.

Step6  Click Enter to continue.
A database name displays.

Step7  Verify the database instance name.

~

Note  If the database is located on a Solaris or Linux system, the case
(uppercase, lowercase) of the characters in the database instance name
must be a case-sensitive match of the name of the database directory
located under the oradata directory (e.g., /uol/app/oracle/oradata) Oon
the database host. Look in the oradata directory to ensure that, when you
enter the database instance name, it is a case-sensitive match.
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Step 8  Click Enter to continue.
The setup accounts script prompts you for the database instance name.
Step9  Enter the database instance name obtained in step 7.
The setup_accounts script prompts you for the user password.
Step 10 Enter the same database user account password that was entered during VNDS
installation and written down in Table A-1 on page A-14.
A message displays to inform you that the VNDS user account and all data will
be deleted by this script.
Step 11  Click Enter to continue.
The setup_accounts SQL script configures database storage for use by
Cisco VNDS and sets up the user account. After the script finishes, the Oracle
account information for Cisco VNDS is the user name and password from
Table A-1 on page A-14. A log of script actions is saved to the following location:
<install dirs>\setup_ accounts.<timestamp>.log
N
Note ~ When you run this script for the first time, several SQL error messages
appear. You can ignore these messages. The messages are the result of the
script trying to remove VNDS table and user accounts that do not exist
prior to this script being run for the first time.
Step 12 Type quit at the sor> prompt to exit sqlplus.
If the setup_accounts script recommended changing your database settings during
step 5, and you agree with the recommended changes, see Modifying Database
Parameters (Windows), page 5-20 at this time.
If you do not need to change your database settings or choose not to change them,
see Verifying the Oracle Configuration for Cisco VNDS (Windows), page 5-21 to
verify that Oracle is configured correctly for use with Cisco VNDS.
Installation Guide for Cisco Configuration Assurance Solution
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Modifying Database Parameters (Windows)

Perform Modifying Database Parameters (Windows), page 5-20 on the Oracle 9i
database host to modify database parameters. The database parameter changes
improve VNDS performance when working with large networks and will increase
Oracle memory requirements.

Do not modify database parameters for Oracle 10g unless instructed to do so by
Cisco Technical support.

A

Note = Work with your Database Administrator to run this script.

Modifying Database Parameters (Windows)

Stepl  Log into Oracle using the system account.
* For a local Oracle database installation:
Type sglplus system/<system password> in the command window.

« If the Oracle database is not on the same host system as Cisco VNDS, then
perform the following steps:

Type sglplus system/<system password>@<DB TNS Service Name>

For example, if the Database is remote with a TNS Service Name of 092avnes
and the Oracle system password is magic, type:

sglplus system/magic@o92avnes
Step2  Enter the following command at the sor> prompt:
@dbparamchg.sqgl

A message shows the path to the Oracle spfile that contains the parameters for
your database.

Step3  Make a backup copy of the spfile at the path specified in the previous step.

Step4  Press Enter as many times as needed to step through information messages
produced by this script.

When the script is done, a list of the changed parameters and their new settings
appears with a reminder to restart the Oracle DB service for the changes to take
effect.
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Step 5
Step 6

Step 7

Verifying the Oracle Configuration for Cisco VNDS (Windows)

Type quit at the sor> prompt to exit sqlplus.
Use the Windows Service Manager to stop and restart the Oracle database service.

a. From the desktop, select Start > Settings > Control Panel > Administrative
Tools > Services to open the Windows Service Manager.

b. Select the service named OracleService<DB SID>.
c. Right-click on the service, and select Stop from the menu.

d. After the Service Control progress dialog completes, right-click on the
service, and select Start from the menu to restart the service.

If the Oracle database service fails to restart, restore the original spfile for the
database and repeat step 6 to recover.

See “Verifying the Oracle Configuration for Cisco VNDS (Windows)” section on
page 5-21 to verify that you can connect to the database through the VNDS
account.

Verifying the Oracle Configuration for
Cisco VNDS (Windows)

Perform the follow procedure on the VNDS host to verify that you can connect to
the database through the VNDS account.

Verifying the Oracle Configuration (Windows)

Stepl  Open a command window.

Step2  Navigate to the VNDS installation directory.

Step3  Verify that you can log in into Oracle using the VNDS account.
» For a local Oracle database, enter the following command:

sqlplus <user names/<passwords>
Use the user name and password from Table A-1 on page A-14.
» For a remote Oracle database, enter the following command:
| oL-11600-01
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Step 4

Step 5

Step 6
Step 7

sqglplus <user names/<password>@<DB TNS Service Name>

Use the user name and password from Table A-1 on page A-14. For example,
if the database is remote with a TNS Database Service Name of 092avnes and
the VNDS username and password are vnes and pwd respectively, enter:

sglplus vnes/pwde@o92avnes

If Oracle configuration was not successful, error messages display indicating that
login has been denied.

Reconfigure the Oracle database and verify again.

If configuration of the Oracle account for Cisco VNDS was successful, an Oracle
banner, and a connected To: message appears.

Type quit at the sor> prompt to exit.
Test the Oracle database configuration.
a. Enter the following command:

vnes.bat DBAUTOTEST

Tests run to verify that the VNDS account can perform needed operations in
Oracle.

Output is written to the command window and a separate java window opens
to display a summary of results.

b. Review DBAUTOTEST results.

N

Note Do not proceed until all tests pass. Figure 5-1 on page 5-23 shows a
successful result.

If any of the database tests fail, contact Cisco Technical Support (as described
in “Obtaining Technical Assistance” section on page fm-xii).

When all database tests pass, continue with your installation roadmap.
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Figure 5-1 Example of Successful DBAUTOTEST Results
| £ DatabaseAutoTestResult =1 =1 '
I Comrmand/Test Summary Arguments/Exalanation [ I Result '
: ping network connectivity to database host using ping localhost i passed :
Imsping using oracle's tnsping command 0O92mML23 passed .
Jthin-connection jdhbc thin connection connStr: jdbeoracle:thin:@localhost1521:092, userNarne: FSUSER |passed '
soci-connection ocif connection with jdbc ConnEtr: jdbc:oracle:ocid.@092ML23 | userMame: FEUSER passed '
itablespace FS1DATI creating table and delefing table in tablespace can create a table in this tablespace passed '
Wtablespace FS110X1 creating table and deleting table in tablespace can create a table inthis tablespace passed 1
'tablespace VNEBLOB creating table and delefing table in tablespace can create a table in this tablespace passed '
‘tahlespace WNELARGE  creating table and deleting table in tablespace can create 3 table in this tablespace passed '
:tab\espace YNELGIDX creating tahle and deleting table in tablespace can create a tahle in this tablespace passed :
Jfahlespace CA creating table and deleting table in tablespace can create 3 table in this tablespace passed .
Jahlespace CAIDXI creating tahle and deleting table in tablespace can create a tahle in this tablespace passed '
Jtablespace FS1TMP1 creating table and delefing table in tablespace termporary tablespace exists passed f
HEG UL creating and deleting database synonym created and dropped test synornvrm passed '
1|schemayersion checking the existing and new YNE Scherna version  |projectophet Schemaveris: 2.38 passed '
*urellKnownd checking the well known ids in db and initres current well known id : 0 passed '
' '
' '
' '
' '
' '
' '
' '
' '
' '
' '
' '

VNDS program installation and database configuration are now complete.
Proceed to Verifying the VNDS Software Installation (Windows), page 5-23 to
verify the VNDS installation.

Verifying the VNDS Software Installation
(Windows)

After the database has been configured and verified, perform the following
procedure to verify that the VNDS software is installed correctly.

Verifying the VNDS Installation (Windows)

Step1  Verify that the license server specified during installation has required licenses
installed.

~

Note Do not proceed until you have verified that the appropriate licenses are
available.

Installation Guide for Cisco Configuration Assurance Solution
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Step2  Open the Cisco Configuration Assurance Solution Control Panel from the
Program Group shortcut as follows.

Start > Programs > Cisco Configuration Assurance Solution 2.0 >
Virtual Network Data Server

Within a minute, the Cisco Configuration Assurance Solution Control Panel
appears.

Step3  Start VNDS services from the Control Panel by clicking the Start Services button
on the tool bar.

A progress dialog appears, and within a few minutes, service start-up completes.

Step4  Stop VNDS services from the Control Panel by clicking the Stop Services button
on the tool bar.

A progress dialog box appears; services should stop within a few minutes.

~

Note  If the Control Panel fails to open, services fail to start or stop, or error
dialog boxes appear, there is a problem with the installation. Review
Release Notes for known issues and workarounds; you can also search for
troubleshooting information in the FAQ database at the Cisco Quick
Support Center. Contact Cisco Technical Support for assistance if
problems persist (for more information, see “Obtaining Technical
Assistance” section on page fm-xii).

Step5  Verify communication with the VNDS Web Server via HTTP.

a. Start the Cisco Virtual Network Data Server Web Service using the Windows
services window.

b. Open a web browser and enter the URL for the VNDS Web Console.

<protocols://<hosts>:<port>/vnes

For example, if the VNDS host is myhost.myco.com and the http port is 9190,
enter the following:

http://myhost.myco.com:9190/vnes

c. Close the browser window.
Step6  Click the Exit button on the Control Panel tool bar to exit from Cisco VNDS.

Step7  Some VNDS services continue to run in the background. If you want to
completely shut down Cisco VNDS, stop all services.
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To stop all services, do the following:
a. Open a commend window and navigate to theVNDS install directory.
b. Enter the following command:

vnes.bat /svc_cmd stop ALL

Installation Guide for Cisco Configuration Assurance Solution
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CHAPTER 6

Installing
Cisco Virtual Network Data Server

(Linux)

This chapter describes how to install the Cisco Virtual Network Data Server
program on Linux.

System Requirements
A Y

Note  The host for Cisco Virtual Network Data Server must meet minimum system
requirements. If the host system does not meet minimum requirements, do not
install Cisco VNDS. For more information, see
Cisco Virtual Network Data Server: System Requirements, page 3-1.

If the host system does not have an Oracle database or an Oracle client
installation, but meets all other requirements, install Oracle before installing
Cisco VNDS as described in the “Installation Workflows: Overview” section.

Installation Guide for Cisco Configuration Assurance Solution
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Installation Workflows: Overview

Note

This chapter covers the installation scenarios you might encounter with
Cisco VNDS on Linux. The procedures you must follow depend upon whether
VNDS uses a local or a remote database.

Select the installation workflow appropriate for your circumstances. Follow the
procedures in your workflow to install Cisco VNDS.

e Initial VNDS Installation (Linux/Local Oracle Database), page 6-2
« Initial Cisco VNDS Installation (Linux/Remote Oracle Database), page 6-3

VNDS software is installed in HTTP mode by default. After successful
installation and verification of the VNDS software, HTTPS may be configured.
See the “HTTPS Mode” section of the Release Notes for more information.

Initial VNDS Installation (Linux/Local Oracle Database)

Step 1

Step 2

Step 3

Step 4

If you are installing Cisco VNDS for the first time and will install Oracle on the
same host, follow this workflow.

Install the Oracle database on the VNDS host.
For more information, see Oracle Installation Procedures, page B-1.

Collect Oracle database information (see Collecting Oracle Database Access
Information (Linux), page B-3).

Install Oracle TopLink.
See the “Installing Oracle TopLink (Linux)” procedure on page B-4.

N

Note  You must complete the previous steps before you install Virtual Network
Data Server.

Install the Cisco Virtual Network Data Server program (see Installing
Cisco VNDS (Linux), page 6-4).
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Step 5

Step 6

Step 7

Installation Workflows: Overview W

Configure the Oracle database for VNDS (see Configuring the Oracle Database
for Cisco VNDS (Linux), page 6-14).

Verify the Oracle configuration for VNDS (see Verifying Oracle Configuration
for Cisco VNDS (Linux), page 6-19).

Verify the VNDS installation (see Verifying the VNDS Software Installation
(Linux), page 6-21).

Initial Cisco VNDS Installation (Linux/Remote Oracle

Database)

Step 1

Step 2

Step 3

Step 4

If you are installing Cisco VNDS for the first time and will install Oracle on a
different host, follow this workflow:

Install the Oracle database on the remote host.

For information about installing the Oracle database, see Appendix A, “Oracle
Procedures (Windows)” or Appendix B, “Oracle Procedures (Linux)”.

Install the Oracle client on the host for Cisco VNDS.

S

Note  Install the version of the client that matches the version of the database
that you installed in step 1.

For more information, see Appendix B, “Oracle Procedures (Linux).”

Collect Oracle database information (use the procedure for the platform on which
the remote database is installed):

e “Collecting Oracle Database Access Information (Windows)” procedure on
page A-13

e “Collecting Oracle Database Access Information (Linux)” procedure on
page B-3

Install Oracle TopLink.
See the “Installing Oracle TopLink (Linux)” procedure on page B-4.

[ oL-11600-01

Installation Guide for Cisco Configuration Assurance Solution



Chapter 6 Installing Cisco Virtual Network Data Server (Linux) |

[ | Installing Cisco VNDS (Linux)

~

Note  You must complete the previous steps before you install Virtual Network
Data Server.

Step5  Install the Cisco Virtual Network Data Server program (see Installing
Cisco VNDS (Linux), page 6-4).

Step6  Configure the Oracle database on the remote host (see Configuring the Oracle
Database for Cisco VNDS (Linux), page 6-14).

Step 7 Verify the Oracle configuration on the remote host (see Verifying Oracle
Configuration for Cisco VNDS (Linux), page 6-19).

Step8  Verify the VNDS installation (see Verifying the VNDS Software Installation
(Linux), page 6-21).

Installing Cisco VNDS (Linux)

Perform the following procedures to install the
Cisco Virtual Network Data Server program:

1. Performing Pre-Installation Checks for Cisco VNDS (Linux), page 6-4
2. Installing Cisco VNDS (Linux), page 6-5

Performing Pre-Installation Checks for Cisco VNDS (Linux)

Step1  Make sure the Oracle database is up and running.
Enter the following command on the database host:
ps -aef | grep ora_
You should see a number of processes with the following naming convention:
ora_<process>_<sid>

If the Oracle database is not running, contact your database administrator to start
the database.
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If Cisco VNDS is already installed on the host and you are updating to a new
release, perform the following steps to make sure that all VNDS services are
stopped.

a

Log into the VNDS host as root or a user with permission to run VNDS or
switch users to one of these accounts. When switching users, use the
following command:

sSu - <user name>
Navigate to the VNDS installation directory.

Enter the following command to determine whether VNDS services are
running:

ps -aef | grep wrapper

Stop any VNDS services that are running. Navigate to the VNDS installation
directory and enter the following command:

vnes.sh -c¢ stop ALL

Installing Cisco VNDS (Linux)

Stepl  Log into the VNDS host as root or switch users to root. To switch to root, open
a command prompt window and enter the following command:
su - root
Step2  Start the installer.
a. Insert the Cisco Virtual Network Data Server installation CD into the CD
drive of the host, then execute the cvnds-2.0-1in-k9.bin program.
As an example, open a command window and navigate to the folder that
corresponds to the CD drive (e.g., /media/cdrecorder), then enter
./cvnds-2.0-1in-K9.bin.
The installer displays an rntroduction panel.
b. Click Next.
The installer displays a Specify database type panel.
Step3  Specify parameters that describe the Oracle installation that Cisco VNDS will
use. The installer prompts you for the following:
* Choose whether the database is local or remote
Installation Guide for Cisco Configuration Assurance Solution
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Step 4

Step 5

Step 6

* Choose whether you are using a 32 bit or 64 bit Oracle
Make your selections, then click Next.
The installer displays a Specify an Oracle database panel.

Specify the Oracle database that Cisco VNDS will use. The installer prompts you
for the following database access information:

« Database TNS Service Name
e Database SID

* Database Hostname

* Local Oracle Installation Dir
» Base Dir for Database

Fill in each field with the information collected in Table B-1 on page B-3 and
click Next.

The installer displays the specify account information for the Oracle
database panel.

Specify values for the account that Cisco VNDS will use to access the Oracle
database.

* Database User Name
« Database Password
e Confirm Password

Fill in each field with the information collected in Table B-1 on page B-3 and
click Next.

A
Note  Select a user name that is dedicated for use by Cisco VNDS. DO NOT use
SYS or SYSTEM for the Local Database User Name.

If you specified a remote database in Step 3, the installer displays the choose the
oracle version panel. Proceed to Step 6.

If you specified a local database in Step 3, the installer prompts you for the
location of the Oracle TopLink files. Jump to Step 7.

Specify the Oracle version for the remote database. The choices are:

e Oracle9i
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¢ OraclelOg

Choose the appropriate Oracle version, then press Next to continue. The installer
prompts you for the location of the Oracle Toplink files.

The installer prompts you for the location of Oracle Toplink files required by
Cisco VNDS.

A

Note  Note: Version 9.0.3.5 of Oracle Toplink is required.

a. If you have Toplink installed to the default path within your existing Oracle
installation, the default path shown in this panel is the correct path. Locate
the path on your system that contains the following Toplink files:

tl core.jar tl tools.jar tl x.jar

b. Click Choose and browse to the directory of the required Oracle Toplink files.
Click Select to complete your choice.

c. Click Next. If the required files are not found at the selected path, an error
dialog appears. Click one of the following:

— OK to try again to select a path.
— Cancel to cancel the installation.
Specify the licensing type (see Licensing Notes, page 6-13 for more information).

a. The installer prompts you for the type of licensing to use. The seiect
Licensing Type panel provides the following choices:

— Access licenses from a remote server

— Serve licenses from a new license server on this computer

— Serve licenses from an existing license server on this computer
b. Choose the licensing type, then click Next.

N

Note  The specified license server must have a valid VNDS license before
you can run the software.

If you selected remote licensing, the installer displays the znter Server Name
and port panel. Proceed to step c.

If you selected local licensing, the installer displays the Znter Port panel.
Jump to step d.
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c. The installer prompts you for the server name and port.
— Type the hostname of the remote license server in the Server field.

— Type the port (port_a, port b, or port_c) used by the remote license
server in the Port field.

— Click Next.

The Choose the Cisco Configuration Assurance Solution Installation folder
panel displays. Proceed to Step 9.

N

Note  Write down the license settings for future reference.

d. The installer prompts you for the port used by the local license server (port_a,
port_b, or port_c)

Accept the default value. Press Next to proceed.

The installer displays the choose the
Cisco Configuration Assurance Solution Installation folder panel.

Proceed to Step 9.
Step9  Specify the VNDS installation directory.

a. Type an installation path in the panel’s path field or use the file browser to
select an installation path. The path you choose cannot contain embedded
spaces.

N

Note  The path you enter is the parent directory for the installation. The
installer adds \VNEServer\<version>_<build#- to the path you
choose.

Note  The installer suggests a default directory. Although you can override the
default, Cisco strongly recommends that you install Cisco VNDS in its
own, program-specific directory. Cisco also recommends that you do not
install multiple Cisco Solution programs (such as Cisco VNDS and
Cisco Audit and Analysis) in the same directory.

b. Press Next.

The installer displays the znter File oOwnership panel.
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Step 10  Specify user and group ownership for the VNDS installation directory. The

Step 11

Step 12

installer prompts you for the following information:
e User ID
e Group ID

N

Note  The user must be a member of the specified group. The user will be the
owner of the VNDS installation directory. Any user that is a member of
the specified group will have appropriate permission to run the VNDS
software.

Type a valid user name and group name into the appropriate fields then press
Next.

The installer displays the choose the

Cisco Configuration Assurance Solution temp folder panel.
Specify the VNDS temporary directory.

Type a temp directory path in the panel’s path field or use the file browser to select
a path. The path you choose cannot contain embedded spaces.

N

Note The temp directory holds temporary working files for the product. The
path you specify is the full path to this directory.

N

Note  Make sure that the specified directory has appropriate write permissions.
The group specified in Step 10 must be able to write to this directory.

a. Press Next.

The installer displays the choose the

Cisco Configuration Assurance Solution config file folder panel.
Specify the VNDS config file archive directory.

a. Type an archive directory path in the panel’s path field or use the file browser
to select a path. The path you choose cannot contain embedded spaces.
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Note

a.

nux)

The archive directory holds collected device configuration files that have
been archived by the product. The path you specify is the full path to this
directory.

Make sure that the specified directory has appropriate write permissions.
The group specified in Step 10 must be able to write to this directory.

Press Next.

The installer displays the configure
Cisco Configuration Assurance Solution panel.

Step 13 Specify server information for this instance of Cisco VNDS. The installer
prompts you for the following information:

Virtual Network Data Server Name
Virtual Network Data Server ID (0-1022)
Virtual Network Data Server Address

Type the primary IP address of the host in the

Cisco Configuration Assurance Solution Address field.

~
Note  The primary IP address is required for all VNDS installations. To

obtain the IP address, open a command window and run the ifconfig
command.

Fill in additional fields if this instance of Cisco VNDS will participate in an
n-tier hierarchy.

Press Next.

The installer displays the configure

Cisco Configuration Assurance Solution Client Cozmectivitypanel.

Step 14  Specify the VNDS Client Connectivity port.

Type a port number or press Next to accept the default value.
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~

Note  The Client Connectivity port is the port on which the Live Update Service
runs. If you enter a non-default port, VNDS clients might be unable to
communicate with this service until you make a corresponding change in
the client preferences.

The installer displays the configure web Server Connectivity panel.
Specify web server connectivity information.
The installer prompts you for the following:
e Virtual Network Data Server HTTP Port
e Virtual Network Data Server HTTPS Port
« Keystore Directory
a. Fill in each field or press Next to accept default values.

~

Note  Write down the web server connectivity settings for future use.

The installer displays the Set Web Server Administrator Password panel.

Specify the password for the administrator (cisco) user account for the VNDS
Web Console. The installer prompts you for the following information:

* Enter administrator password
e Confirm administrator password

Type a password into the password fields or press Next to accept the default
password (cisco).

N,

Note  Write down the admin password. You will need this password to log into
the VNDS Web Console for the first time—VNDS Web Server is installed
in the local authentication mode by default. Once logged into the Web
Console, the admin user may change the admin password, create user
accounts, or change the authentication scheme.

The installer prompts you to configure email notification parameters.
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Step 17 If you want to begin receiving email notification from Cisco VNDS as soon as you
start VNDS services, configure email notifications at this time. Otherwise,
configure notifications when you are ready to begin automated operation
(recommended) using the Notification panel in the VNDS Administrative
Console.

a. Enter the sender, recipients, and subject prefix for VNDS email notifications
or leave these fields blank if you want to configure email notifications
post-installation.

b. Click Next to proceed.
The installer prompts you for email server settings.

c. Enter the SMTP Server, Port, User Name, and Password or leave these fields
blank if you want to configure email notifications post-installation.

d. Click Install.

An installation progress panel shows status messages as VNDS installation
progresses. Installation normally finishes in several minutes. When
installation is complete, the web services note panel displays.

Note  The installer checks the version of the Oracle Toplink files that you chose
in Step 7. If the wrong version files were selected, an error dialog box
appears. Click OK to continue. Before operating Virtual Network Data
Server, you must locate the correct version of the required Toplink files
and copy them to the <install dirs/ext directory.

Step 18 Read the web Services note.

~
Note  VNDS software is installed in HTTP mode. You can optionally configure

HTTPS after you have completed your installation workflow. See the
“HTTPS Mode” section of the Release Notes for more information.

Click Next to proceed.
The installer displays the rnstail complete panel.

Step 19 Click Done to exit the installer.
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~

Note  Installation of VNDS software is now complete. Return to the workflow
you are following and continue with the next step. Do not attempt to start
Cisco VNDS or access the Web Console until you complete all steps in
the installation workflow.

After you have installed VNDS software, see Configuring the Oracle Database for
Cisco VNDS (Linux), page 6-14.

Licensing Notes

You must specify a licensing type for the VNDS software during installation. The
installer provides the following options:

» Access licenses from a remote server—Selecting this option results in the
VNDS software obtaining a license from a remote host.

» Serve licenses from a new license server on this computer—Selecting this
option results in a license server being installed with the VNDS installation.
The license server executable installed by Cisco Virtual Network Data Server
version 4.0 is the same version license server that is included with programs
in other Cisco Solution packages (such as the program included in the Cisco
Configuration Assurance Solution) . To start the license server, enter the
following from a command prompt:

vnes.sh -1 <license server host> -p <port> LS

S

Note  The license server program must be manually restarted when the
server reboots.

» Serve licenses from an existing license server on this computer—Selecting
this option configures Cisco VNDS to use a license server that is already
installed on the host as part of an existing Cisco VNDS or Cisco Solution
package. No license server is installed by the VNDS installer.
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~

Note  The specified license server must have a valid VNDS license before you
can run the software. Check to see if the license server has a valid VNDS
license before you attempt to run the VNDS software. Add a license, if
needed. Refer to the Cisco Configuration Assurance Solution User
Guide, Administration chapter, Licensing Operations section for
instructions on adding a license.

Configuring the Oracle Database for Cisco VNDS

(Linux)

N

Warning

After VNDS software is installed, the Oracle database must be configured for use
by VNDS. This involves running an SQL script named setup_accounts.sql that
creates tablespaces for the database and a VNDS access account. This SQL script
is run on the host system for the Oracle database.

Do not modify the setup_accounts.sgl script. This can cause the installation
to fail or prevent VNDS from operating correctly.

See Configuring the Oracle Database (Linux), page 6-14 for instructions on
configuring the Oracle database.

Configuring the Oracle Database (Linux)

Step 1

Step 2

Step 3

Log into the VNDS host as oracle or switch users to the oracle account. To
switch to oracle, open a command prompt window and enter the following
command:

su - oracle

Copy the SQL scripts from the VNDS installation directory to a directory on the
database host where the oracle user has execute permission. The SQL scripts
have a file extension of .sql.

Navigate to the directory that contains the SQL scripts.
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Stay in the command window on the database host (as oracle) and continue with
step 4.

Step4  Log into Oracle using the system account.

» For a local Oracle database installation, type the following command in the
command window:

sglplus system/<system password>

» For aremote Oracle database installation, type the following command in the
command window:

sqlplus system/<system password>@<DB TNS Service Name>

For example, if the Database TNS Service Name is 092avnes and the account
password is magic, type:

sglplus system/magic@o92avnes
Step5  Enter the following command at the sor> prompt:
@setup accounts.sql

A message banner appears that states how much free disk space is required on the
disk that hosts the database.

~
Note  If you do not have sufficient disk space available to run this script, free up

sufficient disk space before proceeding. If you want to cancel the script,
press Ctrl-C or close the command window.

Step 6  Press Enter to continue.
A message banner displays a notification about Device and Platform Info.
» For Oracle9i, proceed to step 7.
e For Oraclel10g, jump to step 8.

N

Note  If you want to cancel the script, press Ctrl-C or close the command
window.

Step7  Press Enter to continue.
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Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

When configuring Oracle 9i, database parameters are analyzed and a message
banner displays with a list of database parameters, database parameter settings,
and whether the parameters meet recommended settings. A log of database
analysis results is saved to <install dir>\analyzedb.<timestamp>.log.

~

Note  If all parameters meet recommended settings, no further action is
required. If one or more parameters do not meet recommended settings,
the installer recommends that you run the dbparamchg. sgl script after
you complete this procedure. This will improve data import performance
with large networks and increase Oracle memory requirements.

Press Enter to continue.

A database name appears. If more than one database is available, contact your
database administrator to find out which database name to use with Cisco VNDS.

Verify the database instance name.

N

Note  If the database is located on a Solaris or Linux system, the database
instance name must be a case-sensitive match of the name of the database
directory located under the oradata directory (for example,
/uol/app/oracle/oradata) on the database host. Look in the /oradata
directory to ensure that when you enter the database instance name it is a
case-sensitive match.

Press Enter to continue.

The setup accounts script prompts you for the database instance name.
Enter the database instance name obtained in step 9.

The setup accounts script prompts you for the user password.

Enter the same database user account password that was entered during VNDS
installation and written down in Table B-1 on page B-3.

The script informs you that the VNDS user account and all data will be deleted by
this script.

Press Enter to continue.
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The setup accounts SQL script configures database storage for use by VNDS
and sets up the user account. After the script finishes, the Oracle account
information for Cisco VNDS is the user name and password from Table B-1 on
page B-3. A log of script actions is saved to

<install dirs>\setup_accounts.<timestamp>.log.

a~

Note  When you run this script for the first time, several SQL error messages
appear. You can ignore these messages. The messages are the result of the
script trying to remove VNDS table and user accounts that do not exist
prior to this script being run for the first time.

Type quit at the sor> prompt to exit sqlplus.

If the setup_accounts script recommended changing your database settings during
step 7, and you agree with the recommended changes, see Modifying Database
Parameters (Linux), page 6-17 at this time.

If you do not need to change your database settings or choose not to change them,
see Verifying Oracle Configuration for Cisco VNDS (Linux), page 6-19 to verify
that Oracle is configured correctly for use with Cisco VNDS.

Modifying Database Parameters (Linux)

Perform Modifying Database Parameters (Linux), page 6-18 on the Oracle 9i
database host to modify database parameters. The database parameter changes
improve VNDS performance when working with large networks and will increase
Oracle memory requirements.

Do not modify database parameters for Oracle 10g unless instructed to do so by
Cisco Technical support (see Obtaining Technical Assistance, page fm-xii).

N

Note  Work with your Oracle Database Administrator to run this script.

[ oL-11600-01
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Modifying Database Parameters (Linux)

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6
Step 7

Step 8
Step 9

Log into the database host as oracle or switch users to the oracle account. To
switch to oracle, open a command prompt window and enter the following
command:

su - oracle
Open a command window.

Navigate to the VNDS installation directory or directory where you copied the
VNDS SQL scripts.

Stay in the command window on the database host (as ) and proceed with Step 4.
Log into Oracle using the system account.

« For a local Oracle database installation, type the following command in the
command window:

sglplus system/<system password>

» If the Oracle database is not on the same host system as Cisco VNDS, type
the following command in the command window:

sglplus system/<system password>@<DB TNS Service Name>

For example, if the Database TNS Service Name is 092avnes and the account
password is magic, type:

sglplus system/magice@o92avnes
Enter the following command at the sor> prompt:
@dbparamchg.sql

A message is displayed that shows the path to the Oracle spfile that contains the
parameters for your database.

Make a backup copy of the spfile at the path specified in the previous step.

Press Enter as many times as needed to step through information messages
produced by this script.

When the script is done, a list of the changed parameters and their new settings
appears with a reminder to restart the Oracle DB service for the changes to take
effect.

Type quit at the sor> prompt to exit sqlplus.

Stop and restart the Oracle database service.
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Step 10 If the Oracle database service fails to restart, restore the original spfile for the
database and repeat step 9 to recover.

See Verifying Oracle Configuration for Cisco VNDS (Linux), page 6-19 to verify
that you can connect to the database through the VNDS account.

Verifying Oracle Configuration for Cisco VNDS
(Linux)

Perform the following procedure on the database host to verify that Oracle is
configured correctly for use with Cisco VNDS.

Verifying the Oracle Configuration (Linux)

Stepl Log in to the database host as oracle or switch users to oracle. To switch to
oracle, open a command prompt window and enter the following command:

su - oracle
Step2  Open a command window.
Step3  Verify that you can log into Oracle using the VNDS account.
« For a local Oracle database, enter the following command:
sqlplus <user names/<passwords
Use the user name and password from Table B-1 on page B-3.
¢ For a remote Oracle database, enter the following command:
sqlplus <user names>/<password>@<DB TNS Service Name>

Use the user name and password from Table B-1 on page B-3. For example,
if the Database TNS Service Name is 092avnes and the VNDS username and
password are vnes and pwd respectively, enter:

sqlplus vnes/pwd@o92avnes

Step4  If Oracle configuration was not successful, error messages notify you that login
has been denied.

Installation Guide for Cisco Configuration Assurance Solution
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» Reconfigure the Oracle database and verify again.

Step5  If configuration of the Oracle account for Cisco VNDS was successful, an Oracle
banner, and a connected To: message appears.

Step6  Type quit at the sor> prompt to exit.
Step 7  Test the Oracle database configuration.

a. Switch users to root or a user with permission to run Cisco VNDS. When
switching users, open a command prompt window and enter the following
command:

su - <user>

For example, you might enter su - vnds_user
b. Navigate to the VNDS installation directory.

Enter the following command:

vnes.sh DBAUTOTEST

Tests run to verify that the VNDS account can perform needed operations in
Oracle.

Output is written to the command window and a separate java window opens
to display a summary of results.

c. Review DBAUTOTEST results.

~

Note Do not proceed until all tests pass. Figure 6-1 shows a successful
result.

— If any of the database tests fail, contact Cisco Technical Support for
assistance and provide the DBAUTOTEST results (for more information,
see Obtaining Technical Assistance, page fm-xii).

— When all database tests pass, continue with your installation workflow.
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Figure 6-1

Verifying the VNDS Software Installation (Linux) W

Example of Successful DBAUTOTEST Results

= DatabaseAutoTestResult @l - [o] x|

! '
[ Cammand/Test Summary ArgumentsiExplanation [ \ Result '
1ping netwark connectivity to database host using ping localhost passed 1
ntnsping using oracle's thaping cormmand 082ML23 passed [
ythin-connection Jdbe thin connection connStr: jdbeoraclethin:@localhost1521:092, userlame: FSUSER |passed [
aci-connection ociB connection with jdbe ConnStr jdbeoracleociB:@0oa2ML23 | userName: FSUSER passed 1
wtablespace FS1DAT1 creating table and deleting table in tablespace cah create atable in this tablespace passed [
tablespace FS11Dx1 creating table and deleting table in tablespace cah create atable in this tablespace passed [
tablespace VNEBELOB creating table and deleting table in tablespace cah create atable in this tablespace passed [
ytablespace VNELARGE creating table and deleting table in tablespace cah create atable in this tablespace passed 1
mtablespace WNELGIDK creating table and deleting table in tablespace cah create atable in this tablespace passed 1
ytablespace CA creating table and deleting table in tablespace cah create atable in this tablespace passed 1
itablespace CAIDX1 creating table and deleting table in tablespace can create atable in this tablespace passed 1
atablespace FS1TMP1 creating table and deleting table in tablespace temparary tablespace exists passed 1
|synonym creating and deleting database synanym created and dropped test synanym passed 1
ischemavarsion checking the existing and new WVMNE Schemawversion  |projectopnet Schemaveris: 2.38 passed 1
afwelliKnownld checking the well known ids in db and initres current well khown id 0 passed 1
[ '
[ '
1 '
1 '
[ '
[ '
1 '
[ '
[ '

VNDS installation and database configuration are now complete. Proceed to
Verifying the VNDS Software Installation (Linux), page 6-21 to verify the VNDS
installation.

Verifying the VNDS Software Installation (Linux)

After the database has been successfully configured for Cisco VNDS, perform the
following procedure to verify that the VNDS software is installed correctly.

Verifying the VNDS Installation (Linux)

Step 1

Step 2

Verify that the license server specified during installation has the required licenses
installed.

N

Note Do not proceed until you have verified that the appropriate licenses are
available.

Log in to the VNDS host as a member of the VNDS group or switch to a user that
is a member of the VNDS group. When switching users, open a command prompt
window and enter the following command:

[ oL-11600-01
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Step 3

Step 4

Step 5

Step 6

su - <user>
For example, you might enter su - vnds_user
Open the cisco Virtual Network Data Server Control Panel as follows:
a. Open a command window and navigate to the VNDS installation directory.
b. Enter the following command:

vnes.sh CP

Within a minute, the ¢cisco Virtual Network Data Server Control Panel
appears.

Start VNDS services from the Control Panel by clicking the Start Services button
on the tool bar.

A progress dialog appears, and within a few minutes, service start-up completes.

Stop VNDS services from the Control Panel by clicking the Stop Services button
on the tool bar.

A progress dialog appear appears; services should stop within a few minutes.

S

Note  If the Control Panel fails to open, services fail to start or stop, or error
dialog boxes appear, there is a problem with the installation. Contact
Cisco Technical Support for assistance if problems persist (for more
information, see Obtaining Technical Assistance, page fm-xii).

Verify communication with the VNDS Web Server via HTTP.

a. Start the VNDS Web Service by entering the following command:
vnes.sh -c start WS
~

Note  You must start the Web Service manually before you can access the
Web Console.

b. Open a web browser and enter the URL for the
Cisco Virtual Network Data Server Web Console.

<protocols://<host>:<port>/vnes

As an example, if the VNDS host is myhost.myco.com and the http port is
9190, enter:
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http://myhost.myco.com:9190/vnes
The login page displays.
c. Close the browser window.
Step 7  Click the Exit button on the Control Panel tool bar to exit from Cisco VNDS.
Step8  Some VNDS services continue to run in the background. If you want to

completely shut down VNDS, stop all services (vnes.sh -c¢ stop ALL).

)

Note  If you manually stop the Web Service or shut down VNDS by stopping all
services, you must manually start the Web Service before you can access
the Web Console. See substep a. of Step 6.

N

Note  Before using Virtual Network Data Server, you must change the default
port that Cisco Configuration Assurance Solution’s Audit and Analysis
uses to connect to VNDS. Search the known product issues (as described
in Appendix D, “Known Issues”) for details on how to configure Audit
and Analysis to successfully import from a Virtual Network Data Server
running on Linux.
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Installing Cisco Report Server

This chapter describes the following procedures:
e Installing Cisco Report Server (Windows), page 7-1
» Installing Cisco Report Server (Linux), page 7-3
» Migrating Data from a Previous Installation, page 7-5

» Configuring Cisco Report Server, page 7-6

Installing Cisco Report Server (Windows)
N

Note  You can install Cisco Report Server as either a service or an application. If you
install it as a service, a user does not need to be logged on for Cisco Report Server
to run, and Cisco Report Server starts and runs automatically when the host is
rebooted. You can install Cisco Report Server as an application if the previous
requirements do not apply or for debugging purposes. However, you must decide
which method of operation you want to use before installing the
Cisco Report Server. You cannot change the method after installation.

P

Warning  When selecting or creating the installation directory for
Cisco Report Server, make sure the directory name DOES NOT contain
spaces.

Installation Guide for Cisco Configuration Assurance Solution
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Step 1
Step 2
Step 3

Step 4
Step 5

Step 6

Step 7

Step 8

Step 9

Log in as Administrator before inserting the CD.
Insert the installation CD into the CD-ROM drive.

Use Start > Run and execute the installer. Enter the following installer name:
setup CCAS.exe

The Cisco Report Server installation wizard appears.
The Introduction panel appears. Press Next to continue.

The installer displays a panel to choose the installation path. Select a path and
press Next.

By default, Cisco Report Server uses port 9090 for HTTP traffic and 8443 for
HTTPS traffic. Determine if these ports are free. If either default port is in use,
you must select a different (unused) port in Step 7.

The installer displays a panel to select the HTTP/HTTPS ports and Keystore
directory used by Cisco Report Server. Specify the desired ports and path (or
leave the default settings).

S

Note  During the installation process, you are prompted to specify the
Cisco Report Server ports for HTTP (default: 9090) and HTTPS (default:
8443), as well as the Keystore Directory (default:
<install dirs\security). Make a note of this information. You will
need this information when installing or configuring applications that
publish to the Cisco Report Server. The applications will refer to this port
as the “Cisco Report Server port.”

After you set these fields, click Next.

The installer prompts you for the password for logging in to the
Cisco Report Server. Enter the desired password and click Next.

The installer displays a panel asking whether you want to run Cisco Report Server
as a Windows service.

» Set the checkbox to run Cisco Report Server as a Windows service.
» Clear the checkbox to run Cisco Report Server as an application.

Then click Next to continue.
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Step 10

Step 11

Installing Cisco Report Server (Linux) W

~

Note  If you run Cisco Report Server as an application, Program Group
shortcuts are provided to start and stop Cisco Report Server.

If you are installing Cisco Report Server to run as a Windows service, the installer
displays a panel to ask whether you want to start the Cisco Report Server service
after installation. Set the checkbox to start services after installation. Clear the
checkbox to prevent the start of services after installation. Press Install to
continue. An Installing Cisco Report Server panel appears.

From the Install Complete window, click Done.

This concludes the Cisco Report Server installation. Look at the following
procedures and perform them if needed:

» Migrating Data from a Previous Installation, page 7-5
» Configuring Cisco Report Server, page 7-6

When you are finished with all Cisco Report Server installation procedures,
return to the installation workflow and continue with the next step.

If you plan to access the Cisco Report Server through a firewall, make sure to
open the port specified in the installation process to HTTP traffic in the firewall
configuration. Also, if the machine on which you are installing the

Cisco Report Server has a sleep/power save mode, make sure you turn off this
sleep/power save mode. Otherwise, the Cisco Report Server will suspend
operations when the machine goes into sleep or power save mode.

Installing Cisco Report Server (Linux)

A

Warning  When selecting or creating the installation directory for
Cisco Report Server, make sure the directory name DOES NOT contain
spaces.
Stepl Login as root.
Installation Guide for Cisco Configuration Assurance Solution
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Step 2

Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Insert an installation CD in your CD-ROM drive. (You can install the CDs in any
order.)

Move to the unix directory on the CD, which is typically /mnt /cdrom/unix.
Enter the following command:
/ReportServer_Cisco_25APL2_273_linux.bin

The installer displays a panel to choose the installation path. Select a path and
press Next.

By default, Cisco Report Server uses port 9090 for HTTP traffic and 8443 for
HTTPS traffic. Determine if these ports are free. If either default port is in use,
you must select a different (unused) port in Step 7.

The installer displays a panel to select the HTTP/HTTPS ports and Keystore
directory used by Cisco Report Server. Specify the desired ports and path (or
leave the default settings).

~
Note  During the installation process, you are prompted to specify the
Cisco Report Server ports for HTTP (default: 9090) and HTTPS (default:
8443), as well as the Keystore Directory (default:
<install dirs\security). Make a note of this information. You will
need this information when installing or configuring applications that
publish to the Cisco Report Server. The applications will refer to this port
as the “Cisco Report Server port.”

After you set these fields, click Next.

The installer prompts you for the password for logging in to the
Cisco Report Server. Enter the desired password and click Next.

From the Install Complete window, click Done.

This concludes the Cisco Report Server installation. Look at the following
procedures and perform them if needed:

e Migrating Data from a Previous Installation, page 7-5
* Configuring Cisco Report Server, page 7-6

When you are finished with all Cisco Report Server installation procedures,
return to the installation workflow and continue with the next step.
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Migrating Data from a Previous Installation

Migrating Data from a Previous Installation

_A

Warning

~

Note

If you want to retain information from previous versions of Cisco Report Server,
you can migrate the previous data after installing the new version of
Cisco Report Server. Use the following procedure to migrate the old data.

Migration of reports from previous versions of Cisco Report Server is
supported. However, you must not uninstall the previous version of

Cisco Report Server prior to performing the migration (described in the
“Migrating Data from a Previous Installation” section on page 7-5). Doing
so results in the loss of data from the previous version.

Migration does not move old user data to the new installation. You must manually
recreate user data.

Migrating Data from a Previous Cisco Report Server Version

Step 1
Step 2

Step 3
Step 4

Step 5

Install the newest version of Cisco Report Server.
Log in to the new version of Cisco Report Server as an administrator.

A

Note  To log in to Cisco Report Server for the first time, you can use one of
three preconfigured accounts: admin (password specified during
installation), testl (password: testl), or test2 (password: fest2).

Navigate to Settings > Migration.

Enter the name of the directory for the previous Cisco Report Server version in
the space provided. For example:
C:\Cisco\Cisco Configuration Assurance Solution 1.0\

ReportServer\2.0.1.

Click the Verify button. The migration tool will check to see if the entry is a valid
directory. If the specified directory is not found or does not have any reports, you
will see a warning message and no migration is performed.
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Step 6 Select the checkbox to “Import Custom Folders and Filters”, if desired. This
checkbox will cause the migration tool to import all previously created custom
folders and filters. Not checking this box will not impact the migration of any
reports, however.

Step7  Click Import to complete the migration or Cancel to quit.

Configuring Cisco Report Server

After you install Cisco Report Server, you must configure the administrative
settings. For instructions on how to perform the following tasks, see the
corresponding sections in the Cisco Report Server Administration chapter of the
Cisco Report Server User Guide:

» To log in for the first time, see the “Logging in to Cisco Report Server”
section.

» To set up user accounts and passwords, see the “User Administration”
section.

» To set up secure communications for Cisco Report Server, see the “Secure
Web Portal” section.

* (Optional) To change the activation period for the Cisco Report Server
cleanup operation, see the “Setting the Activation Period” section.

* (Optional) To change the maximum age limit for reports on the
Cisco Report Server, see the “Setting the Maximum Age Limit of Published
Reports” section.
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Installing the OTL Service
(Windows)

Perform the following procedure to install the OTL service on Windows.

The OTL feature is supported on Windows hosts only.

The OTL service can communicate with one and only one instance of

Audit and Analysis. This means that, if you have multiple instances of

Audit and Analysis or Audit and Analysis—SP installed on the same host, and you
want to use OTL with more than one instance, you must install one OTL service
for each instance.

Installing the OTL Service

Step 1

Step 2

Step 3
Step 4

Load the Cisco CAS, Audit and Analysis installation CD into the CD-ROM drive,
or download the installer executable on the same host where
Cisco Audit and Analysis. is installed.

If you want to install the OTL service in a directory that does not yet exist, create
that directory now.

Navigate to the directory containing the OTL installer.
Double-click on the file called Setup.
The InstallShield Wizard opens.
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Step5  Click the Next button to continue with installation.
Step6  Specify the following information, as prompted by the OTL installer:
» The directory where you want to install OTL

e The HTTP port you want the OTL server to use

Note  Be sure to use a unique http port on which Cisco Audit and Analysis will
listen for network events. There must be no other applications listening
on this port. Make sure this is the same port that Cisco VNDS will use to
contact OTL.

Note  To change the HTTP port setting at any time after installation, edit the

setting in the file
<release dirs\sys\configs\global prefs\op_ task_launcher.ef.

Step 7  Click Finish to close the installer when the installation finishes.

Note  Torun OTL, you must make additional configuration steps in other programs. For
more information, see the following section of the product documentation:
Cisco Audit and Analysis User Guide > OPNET Task Launcher
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Managing Licenses

To start a Cisco Solutions program such as Cisco Audit and Analysis or
Cisco Virtual Network Data Server, you must have a valid license for that
program installed on the local or a remote computer.

This chapter describes the following operations:

» Adding a License, page 9-3—Perform this workflow if you have purchased
an initial or additional license and want to add it.

» Upgrading a License, page 9-4—Perform this workflow if you have already
added a Restricted license and want to upgrade it to an Unrestricted license.

« Deregistering a License, page 9-8—Perform this workflow if you need to
deregister a license.

Note  Licenses (that is, the License Manager) must reside on a host that is accessible to
the component program at startup. This can be the local host where the component
program is installed or a remote host. For more information about licensing
options, see the “Product Licensing” section on page 1-7.
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Using the License Manager

You can see which licenses and license servers are installed on your network by
using the License Manager. You can also perform license operations from the
License Manager using the following procedure.

Step1  Start the License Manager for the installed program. On a Windows host, for
example, you might see the following shortcut:

Start > Programs > Cisco Audit and Analysis 2.0 > License Manager

Step2  Inthe License Manager, select the license(s) or license server you want to act on,
then click on the correct operation button on the right.

N,

Note  The License Manager might show some child windows that prompt you
for additional information, such as which product modules to use. You do
not need to specify these options to use the License Manager; generally

you can click OK to accept the default settings and close the child
window.

License Names

License names in the License Manager differ from the Cisco component names.
The following table shows the component names and the license names that
appear for each component.

Table 9-1 Cisco Product Component Names and License Names
Cisco Component Name License Name
Audit and Analysis IT Sentinel

Virtual Network Data Server VNE Server
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Adding a License

Table 9-2 shows the workflow for adding your licenses.

Table 9-2  Adding a License: Workflow

Description Reference

Stepl  Obtain a username and password (if you |Obtaining a Username and Password, page 9-3
have not done so already)

Step2  Add program license(s) using one of the
following methods for each license:

» Express method Adding a License (Express Method), page 9-9

* Browser method (if Express method |Adding a License (Browser Method), page 9-10
does not work)

Contact Cisco Technical Support (if Technical Support for Licensing Operations,
Express and Browser methods do not page 9-16
work)

Note  You must repeat the Add License procedure for every computer on which you want to
add a license.For example, suppose you want to install the Design and Analysis and
Report Server licenses on one computer and the Virtual Network Data Server license
on another computer. In this case, you must do the add-license operation twice—once
for each computer.

Obtaining a Username and Password

To add a license, you must have a valid username, password, and group ID. To
obtain this information, you must register your Cisco CAS product with Cisco
Systems, Inc. Instructions for doing this are listed on the Software License Claim
Certificate that is included in your product installation package. For more
information, see the “Registering Your Cisco Solution Product” section on

page 1-5.

After your registration is confirmed, Cisco will send you an email with a
username, password, and Group ID number. You will need this information when
you add the component licenses as described in the following sections.

Installation Guide for Cisco Configuration Assurance Solution
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After you obtain a username and password, you can add your licenses as described
in the “Adding a Component License (Express Method)” procedure on page 9-9
or the “Adding a Component License (Browser Method)” procedure on page 9-11.

Upgrading a License

Table 9-3 shows the workflow for upgrading your licenses. For information about
different grades of licenses, see the “Product Licensing” section on page 1-7.

Table 9-3 Upgrading a License: Workflow
Description Reference

Stepl  Obtain an Upgrade authorization from Cisco Getting an Upgrade Authorization from
Systems, Inc. Cisco Systems, Inc., page 9-5

Step2  Deregister the original (Restricted) license

using one of the following methods:

» Express method Deregistering a License (Express Method),

page 9-13

Browser method (if Express method does
not work)

Contact Cisco Technical Support (if
Express and Browser methods do not work)

Deregistering a License (Browser Method),
page 9-14

Technical Support for Licensing
Operations, page 9-16
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Table 9-3 Upgrading a License: Workflow (continued)

Description Reference
Step3  Add the upgraded (Unrestricted) version of the
original license using one of the following
methods:
» Express method Adding a License (Express Method),
page 9-9
» Browser method Adding a License (Browser Method),
page 9-10
» Contact Cisco Technical Support (if Technical Support for Licensing
Express and Browser methods do not work) |Operations, page 9-16

Note  You must perform both procedures—that is, deregister the Restricted license and add
the Unrestricted license—before you can use Unrestricted licensing mode. Also, keep
in mind that after you deregister your current (Restricted) license, you will be unable
to use the software until you register the updated (Unrestricted) license.

Getting an Upgrade Authorization from Cisco Systems, Inc.

Step 1

Step 2

Step 3

Step 4

Before you can upgrade a Cisco Solution license, you must obtain an
authorization from Cisco Systems, Inc. To obtain an authorization, do the
following:

Go to the following URL:
http://www.opnet.com/support/cisco_qsp.html

Follow the my paks link to see the Product Authorization Keys you have added
already. Note the PAK of the product that you want to upgrade from Restricted to
Unrestricted.

Go to one of the URLs listed in the*Registration Information” section on
page 1-6.

Follow the instructions on the Cisco licensing page. You must submit the Product
Authorization Key for both the new license and the original license that you want
to upgrade.
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After you submit the requested information, Cisco Systems will email you an
authorization to proceed with the upgrade (go to Step 2 of Upgrading a License,
page 9-4).

Configuring Node Pack Licenses and Notifications

You should purchase node pack licenses based on the size of your network; you
must also register the licenses before you can create network models and run
analyses. (For more information, see Node Pack Licensing, page 1-8.)

Before you create and analyze networks in Cisco Audit and Analysis, you must
configure the node pack licenses and notifications.

Configuring Warnings and Notifications

There are various warning messages to inform you of licensing requirements.
Warning messages display when your network size

e approaches the maximum number of nodes
e reaches the maximum number of nodes
e exceeds the maximum number of nodes

To define notifications, choose License > Notification Settings.

Cisco Audit and Analysis can send warnings and notifications to one or more of
the following: e-mail/pager, automation log, Remedy trouble ticket. Defining
notifications is especially useful when analyses are automated.

Configuring the “Node Pack Configuration” Preference

Cisco Audit and Analysis cannot create or analyze a network when the number of
nodes exceeds the number of nodes defined by the node pack license
configuration. You must set the Node Packet Configuration preference to specify
the number of nodes in your network. This preference has the following
properties:

* Name: Node Pack Configuration
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« Description: Specifies the node pack license obtained at startup and optional
notifications. Valid values are 100_node, 300 _node, 500_node, 1000_node,
2500_node, and 5000_node. You can select multiple node licenses to
combine the values. For example, select 100_node and 300_node to analyze
a 400-node network.

» Tag: node_pack_configuration
* Type: string

e Default: “” (A network with up to 50 nodes can be analyzed if no node pack
license is selected.)

Adding a Module to the Product Options List

After you add a license for a product module, you must update your Product
Options list so that the program requests the module license on startup.

Adding a Module to the Product Options List

Step1  Start the program to which the product module applies.
Step2  In the main program window, choose License > Product Modules.

Step 3 In the Select Product Modules, select the checkbox for the module you have
added. Then click OK.

Step4  For the change to take effect, you must exit and restart the program.

Installation Guide for Cisco Configuration Assurance Solution
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Deregistering a License

Deregistering a License

Table 9-4 shows the workflow for deregistering licenses.

Table 9-4 Deregistering a License: Workflow

Description

Reference

Stepl  Deregister a program license(s) using one

of the following methods for each license:

» Express method

« Browser method (if Express method
does not work)

Contact Cisco Technical Support (if
Express and Browser methods do not work)

Deregistering a License (Express Method),
page 9-13

Deregistering a License (Browser Method),
page 9-14

Technical Support for Licensing Operations,
page 9-16

Refreshing a License

After installing an update to the Cisco Configuration Assurance Solution
software, you must refresh your licenses by contacting Cisco Systems as
described in the “Technical Support for Licensing Operations” section on

page 9-16.
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Adding a License (Express Method)

Note

Note

The following procedure is the quickest and easiest way to add a license. This
method requires that your computer be able to communicate directly with the
Cisco Solutions license-registration server over the Internet, either directly or
using a proxy server.

You must perform an add-license procedure (using Express, Browser, or an
alternative method) for every computer to which you want to add a license. For
example, suppose you want to install the Design and Analysis and Report Server
licenses on one computer and the Virtual Network Data Server license on another
computer. In this case, you must go to each computer separately and add the
desired licenses.

The Express method can fail due to firewall restrictions, socket or proxy errors,
or transaction time-outs. If you cannot add the license using this method, try the
Browser method (as described in Adding a License (Browser Method),

page 9-10).

Adding a Component License (Express Method)

Step 1

Step 2

Step 3

Start the License Manager for the installed program. On a Windows host, for
example, you might see the following shortcut:

Start > Programs > Cisco Audit and Analysis 2.0 > License Manager

In the License Manager, click on the green dot that represents the license server
on the computer where you want to add the license. (The license server computer
might not be the same as your local computer.)

Click on the Add License button on the right side of the box.

When prompted to select the transaction method, click Express. This method is
easiest and fastest.

[ oL-11600-01
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Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Enter the Username, Password, and Group ID that you received when you
registered your product with Cisco Systems, Inc. (as described in the “Obtaining
a Username and Password” section on page 9-3).

If the computer uses a proxy server, click on Specify Proxy button and fill in the
information.

The next screen shows a list of available licenses. To select one license, click on
it. To select multiple licenses, control-click or drag on the licenses.

N

Note  Select only the licenses you want to add to the computer of the license
server you have selected. (If you also want to add other licenses to a
different computer, you must repeat this procedure for that computer.)

After you select the licenses you want to add, click on the Add License button at
the bottom. A progress window might appear while the license is added to your
computer. A window should then appear and say that the license operation
succeeded.

When the operation is complete, the Select Product Modules box might appear.
This allows you to select the modules you want to use. (In most cases, you should
select all available modules.)

To start using the program, exit the License Manager and start the program.

Adding a License (Browser Method)

Note

Before using the Browser method, try the Express method. With the Express
method, there is no need to exchange codes and you can add many licenses to your
computer in one operation. Use this procedure if the Express method fails or you
prefer to use the Browser method.

You must perform a license-add procedure (using Express, Browser, or an
alternative method) for every computer to which you want to add a license. For
example, suppose you want to install the Design and Analysis and Report Server

Installation Guide for Cisco Configuration Assurance Solution
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licenses on one computer and the Virtual Network Data Server license on another
computer. In this case, you must go to each computer separately and add the
desired licenses.

If you still cannot add your licenses using this method, see the “Technical Support
for Licensing Operations” section on page 9-16.

Adding a Component License (Browser Method)

Step 1

Step 2

Step 3

Step 4

Step 5

Start the License Manager for the installed program. On a Windows host, for
example, you might see the following shortcut:

Start > Programs > Cisco Audit and Analysis 2.0 > License Manager

License Manager: Click on the green dot that represents the license server on the
computer where you want to add the license. (The license server computer might
not be the same as your local computer.)

Click Add License on the right side of the window.

License Manager: When prompted, click Browser. The following events should
Nnow occur:

e The License Manager launches your Web browser and points it to the Cisco
Solutions Quick Support Page.

* The License Manager shows a transaction code and a hostname.

Web browser: Enter the Username and Password that you received when you
registered your product with Cisco Systems, Inc. (as described in the “Obtaining
a Username and Password” section on page 9-3).

If your browser fails to launch, start it manually and navigate to the following
URL:

http://www.opnet.com/support/cisco_qsp.html

Then follow the My Licenses link in the browser window.

Web browser: Click Perform license operations, then select Add License
(add_permits) and click Next. Back in the License Manager, a dialog box
containing a Transaction Code and Hostname field should appear.

[ oL-11600-01
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Step 6

Step 7
Step 8

Step 9

Step 10

Step 11

Step 12
Step 13

Step 14

Web browser: Copy the Transaction Code and Hostname from the License
Manager into the corresponding fields in the browser. You can either copy/paste
the text or type it manually.

A

Note  Make sure there are no extra spaces before or after the code or hostname.

Web browser: Click Next.

Web browser: When the Select the starting license number page appears, select
the lowest license ID that you want to add to your computer. If you want to add
only one license, select that license.

Web browser: When the Select the ending license number page appears, select the
highest license ID that you want to add to your computer. If you want to add only
one license, select that license. The confirmation page appears.

Web browser: When the License Registration Confirmation page appears, check
that the information is correct, then click Get Approval Code. The approval code
appears.

License Manager: Click Next and enter the approval code that appears in the web
browser.

~

Note  This code can be very long, so make sure you copy the entire approval
code.

License Manager: After you enter the approval code, click Next.

License Manager: If the Select Product Modules license window appears, click
OK. Then click File > Exit to close the License Manager.

To start using the program, exit the License Manager and start the program.
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Deregistering a License (Express Method)

Note

The following procedure is the quickest and easiest way to deregister a license.
This method requires that your computer be able to communicate directly with the
Cisco Solutions license-registration server over the Internet, either directly or
using a proxy server.

The Express method can fail due to firewall restrictions, socket or proxy errors,
or transaction time-outs. If you cannot deregister the license using this method,
try the Browser method (as described in the “Deregistering a License (Browser
Method)” section on page 9-14).

Deregistering a Component License (Express Method)

Step 1

Step 2

Step 3

Step 4
Step 5

Step 6

Start the License Manager for the installed program. On a Windows host, for
example, you might see the following shortcut:

Start > Programs > Cisco Audit and Analysis 2.0 > License Manager

In the License Manager, expand the license file by clicking on the + sign next to
the License file folder icon. Make sure the license you want to deregister is
available (green).

~

Note  If alicense is represented by a “white page” icon, that license is currently
in use. If you want to deregister a license that is in use, quit the component
that is using it, then choose File > Refresh Server Information in the
License Manager.

Select the license you want to deregister by clicking on it. To select one license,
click on it. To select multiple licenses, control-click or drag on the licenses.

Click Deregister License on the right side of the License Manager window.

When prompted to select the transaction method, click Express. This method is
easiest and fastest.

When the Authentication window appears, enter your Username, Password, and
Group ID in the appropriate fields.
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Step 7

Step 8

If the computer uses a proxy server, click Specify Proxy; when the Specify proxy
server information window appears, fill in the requested information and click
OK.

Click OK in the Authentication window.

* A progress window might appear while the license is deregistered from your
computer.

¢ A window should then appear to indicate that the operation succeeded.

Deregistering a License (Browser Method)

S

Note

Before using the Browser method, try the Express method. With the Express
method, there is no need to exchange codes and you can add many licenses to your
computer in one operation. Use this procedure if the Express method fails or you
prefer to use the Browser method.

If you still cannot deregister your licenses using this method, see the “Technical
Support for Licensing Operations” section on page 9-16.

Deregistering a Component License (Browser Method)

Step 1

Step 2

Start the License Manager for the installed program. On a Windows host, for
example, you might see the following shortcut:

Start > Programs > Cisco Audit and Analysis 2.0 > License Manager

License Manager: Expand the appropriate license file by clicking on the + sign
next to the License file folder icon. Make sure the license you want to deregister
is available (green).

S

Note  If alicense is represented by a “white page” icon, that license is currently
in use. If you want to deregister a license that is in use, quit the component
that is using it, then choose File > Refresh Server Information in the
License Manager.
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Step 4
Step 5
Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13
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License Manager: Select the license you want to deregister by clicking on it. To
select one license, click on it. To select multiple licenses, control-click or drag on
the licenses.

License Manager: Click Deregister License.
License Manager: When prompted, click on the Browser button.

The License Manager launches your Web browser and points it to the Cisco Quick
Support page. If your browser fails to launch, start it manually and navigate to the
following URL:

http://www.opnet.com/support/cisco_qsp.html

Web browser: Log in with your Cisco Solution username and password. Then
click on My Licenses.

Web browser: Follow the Perform license operations link, then select Deregister
License (delete_permits) and click Next.

Back in the License Manager, a dialog box containing a Transaction Code and
Hostname field should appear.

Web browser: Copy the Transaction Code and Hostname from the License
Manager into the browser window, then click Next. You can either paste the text
or type it manually.

N

Note  Make sure there are no extra spaces before or after the text you enter.

Web browser: When the Select the starting license number page appears, select
the lowest license ID that you want to deregister from your computer. If you want
to deregister only one license, select that license.

Web browser: When the Select the ending license number page appears, select the
highest license ID that you want to deregister from your computer. If you want to
deregister only one license, select that license.

Web browser: When the License Registration Confirmation page appears, check
that the information is correct, then click Get Approval Code. The approval code
appears.

License Manager: Click Next and enter the approval code that appears in the
browser.
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~

Note  This code can be very long, so make sure you copy the entire approval
code.

Step 14  License Manager: Click Next. The confirmation code appears.

Step 15 Web browser: Enter the confirmation code that appears in the License Manager,
then click Next.

The confirmation code is saved in the Session Log, which is available from the
Help menu in the Cisco Solution software.

Step 16  License Manager: click Done. The license is deregistered and you can now add it
to another computer.

Technical Support for Licensing Operations

If you cannot manage your licenses using the Express or Browser methods, or if
you have additional questions or problems regarding your licenses, you can do the
following:

* Go to the Cisco Solutions Quick Support Page:
http://www.opnet.com/support/cisco_qsp.html

« Contact Cisco Systems as described in the “Obtaining Technical Assistance”
section on page fm-xii
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Uninstalling
Cisco Audit and Analysis

Use the procedures in this chapter to Cisco Audit and Analysis.
» Uninstalling Cisco Audit and Analysis (Windows), page 10-1
e Uninstalling Cisco Audit and Analysis (Linux), page 10-5

Uninstalling Cisco Audit and Analysis (Windows)

This section contains the following procedures:
¢ Uninstalling Cisco Audit and Analysis (Windows/Standard), page 10-1
¢ Uninstalling Cisco Audit and Analysis (Windows/Advanced), page 10-2

Uninstalling Cisco Audit and Analysis (Windows/Standard)

This is the recommended procedure for uninstalling Cisco Audit and Analysis.

A

Warning Do not use this procedure if two different releases of Cisco CAS exist on the
machine and you are removing the older release. Instead, use the

“Uninstalling Cisco Audit and Analysis (Windows/Advanced)” procedure
on page 10-2.
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Uninstalling Cisco Audit and Analysis (Standard)

Step1  If this machine has licenses installed on it and there are no other versions of the
program using the licenses, deregister the licenses. Use either the “Deregistering
a Component License (Express Method)” procedure on page 9-13 or the
“Deregistering a Component License (Browser Method)” section on page 9-14.

Step2  Open the Windows Control Panel from the Start menu:
Start > Settings > Control Panel
Step 3 In the Windows Control Panel, double-click Add/Remove Programs.

Step4  Scroll down the list of installed programs, select the entry for the program you
want to remove, and click Remove. Repeat for the corresponding documentation
and model library. Example names

» Cisco Configuration Assurance Solution 2.0
* Cisco Configuration Assurance Solution Documentation 2.0
e Model Library for Cisco Configuration Assurance Solution 2.0

If you cannot uninstall Cisco Audit and Analysis by using the Add/Remove
Programs control panel, use the “Uninstalling Cisco Audit and Analysis
(Windows/Advanced)” procedure on page 10-2 to ensure that all of the
Cisco Audit and Analysis files have been removed.

Step5  If this machine is running a local license server from the
Cisco Audit and Analysis installation, use the Windows Services Manager to stop
the OPNET License Server service.

In Add/Remove Programs, select and remove “OPNET License Server 12.0.A”.

Uninstalling Cisco Audit and Analysis (Windows/Advanced)

You should do this procedure ONLY if you could not uninstall
Cisco Audit and Analysis using the “Uninstalling Cisco Audit and Analysis
(Windows/Standard)” procedure on page 10-1.
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Uninstalling Cisco Audit and Analysis (Advanced)

Step 1

P

Warning

Step 2

Step 3

A

If this machine has licenses installed on it and there are no other versions of the
program using the licenses, deregister the licenses. Use either the “Deregistering
a Component License (Express Method)” procedure on page 9-13 or the
“Deregistering a Component License (Browser Method)” procedure on

page 9-14.

Do not deregister the Cisco Audit and Analysis license if you will continue
to use a later release of Cisco Audit and Analysis.

Remove the installation directory of the release you are uninstalling. Typical
paths:

e C:\Program Files\Cisco\CiscoCAS2.0

If you had licenses installed on this machine, delete the c: \OPNET license
directory. Be sure you have already deregistered the licenses (as described in
Step 1) before deleting the directory.

Warning Do not delete the license directory if it contains licenses being used by other
versions of Cisco or OPNET software.
Step4  There are shortcuts under the Start > Programs menu. You can remove these
using the Advanced Taskbar properties.
a. Right-click on the Windows task bar.
b. Select Properties. The Taskbar Properties dialog box appears.
c. Choose the Advanced tab.
d. Click the Advanced button under Customize Start Menu. Windows Explorer
opens.
e. Go up the tree to All Users > Start Menu, then delete the directories relating
to the Cisco CAS software being removed.
Step5  Cisco Audit and Analysis creates two directories in your user’s home directory
(op_admin and op_models).
These directories can be deleted if you no longer wish to keep your custom models
and projects.
Installation Guide for Cisco Configuration Assurance Solution
| oL-11600-01 .m



Chapter 10 Uninstalling Cisco Audit and Analysis |

[ | Uninstalling Cisco Audit and Analysis (Windows)

_A

Warning Do not delete these directories if your computer contains other versions of
Cisco or OPNET software.

Step6  Remove the InstallShield bookkeeping files.

a. Make sure that you can view hidden system files on your PC. This procedure
varies on different versions of Windows; ask your system administrator if you
do not know how to do this.

b. Open the following directory:
C:\Program Files\InstallShield Installation Information)\

c. You will see some directories with long names consisting of numbers and
letters surrounded by {} (these are called GUID names). CTRL-F to find files
and look for the following:

Files named: *.ini
Containing text: OPNET, Cisco, or similar

d. Determine which directories apply to the release you are uninstalling, using
one or more of the following methods:

— Look in the *.ini files to see if there is a release number.

— Look at the date timestamp of the *.ini files to see if they match the
installation date of the release you are removing.

— Open the \\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\
CurrentVersion\Uninstall\ registry tree (as described in Step 7),
match the registry keys to the GUID name of the *.ini file’s directory, and
check the release number in the registry.

Make a note of the GUID names of directories that contain matching *.ini
files.

e. Remove the directories that contain *.ini files for the correct release from the
InstallShield Installation directory.

If these directories are not deleted along with the Cisco Solution software,
future Cisco Solution installations might fail.
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_A

Warning

Uninstalling Cisco Audit and Analysis (Linux) W

DO NOT delete the entire InstallShield Installation Information directory,
because other software you have installed may have information installed
here. Be sure to delete only those directories relating to Cisco CAS software.

Remove Registry entries.

Be very careful when you edit the system registry. Incorrect changes to the
registry can cause your Windows system to become unstable. You might
want to create a backup before editing the registry.

f.

Start regedit: From the Windows Start menu, choose Run, then enter regedit
and click OK.

Open the registry tree to \\HKEY LOCAL MACHINE\SOFTWARE\
Delete the registry key for the software being removed. Example registry key:

OPNET Technologies\Cisco Configuration Assurance Solution 2.0\
OPNET\12.0.A

Open the registry tree to \\HKEY LOCAL_ MACHINE\SOFTWARE\Microsoft\

Windows\CurrentVersion\Uninstall\

Match the registry keys with the GUID names you recorded in Step 6d and
delete them from the registry.

Quit regedit.

You have now removed the current release of Cisco Audit and Analysis entirely
from your system.

Uninstalling Cisco Audit and Analysis (Linux)

Perform the following procedure to remove the Application Analysis software
from your computer.

Stepl  Open a command window.
Step2  Enter the following command:
Installation Guide for Cisco Configuration Assurance Solution
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rm -rf <install dirs

where <install dirs is the directory where Application Analysis is installed.
For example, suppose Cisco Audit and Analysis is installed in the following
directory:

/usr/CiscoCAS/2.0
In this case, you would enter:
rm -rf /usr/CiscoCAS/2.0

A

Warning  When you enter this command, take care that you specify the exact
directory where Cisco Audit and Analysis is installed. If you enter the
wrong path—the parent directory, for example—you might delete other
software by accident.
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Uninstalling
Cisco Virtual Network Data Server

Use the procedures in this chapter to uninstall Cisco VNDS:
» Removing VNDS Database Contents (Optional), page 11-1
* Uninstalling Cisco VNDS (Windows), page 11-3
» Uninstalling Cisco VNDS (Linux), page 11-8

* Uninstalling a License Server, page 11-9

Removing VNDS Database Contents (Optional)

If you want to completely remove the tablespace files and user account for
Cisco VNDS 4.0 from a local database, perform Removing Cisco VNDS
Database Contents, page 11-2. You do not need to perform this procedure if
you are updating the Cisco VNDS installation.

A

Warning  Perform this procedure only if you are permanently removing Cisco VNDS
from a system AND want to remove database contents as well as the product
installation.

S

Note  If you choose to perform this procedure, you must do it before you remove the
Cisco VNDS installation.
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Removing Cisco VNDS Database Contents

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7

Log into the Cisco VNDS host using an account with administrator and
ORA_DBA privileges.

Stop services and exit the Control Panel.

Open a command window and use the cd command to set the working directory
to the Cisco VNDS installation directory. An example installation directory might
be:

e Windows: C:\Cisco\VNDServer\4.0.2_ <build number>
e Linux: /opt/cisco/VNDServer/4.0.2 <build numbers

Stop all VNDS background services/daemons by entering the following
command:

« Windows: vnes.bat /svec_cmd stop ALL
 Linux: vnes.sh -c¢ stop ALL
Type: sqlplus system/<password>

A connected to: Oracle banner message appears if you succeed in logging into
Oracle.

To get a list of database instance names, type: select name from v$database;

A list (probably just one item) of database names known to Oracle appears. If
more than one name appears, work with your DBA to identify which one is used
for Cisco VNDS.

While still in sqlplus, type: @drop_accounts.sql <dbname>
where the <dbname> is the one identified in the previous step.
» Progress messages appear as the user account and tablespace files are deleted.

«  When done, the database instance still exists, but the tables and account used
by Cisco VNDS no longer exist.

N

Note  ALL network project data written to the database by Cisco VNDS is
deleted by this procedure.
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Uninstalling Cisco VNDS (Windows)

This section includes the procedures described in the following table.

Procedure Description

Uninstalling Cisco VNDS on Windows |Procedure for uninstalling Cisco VNDS 4.0.
(Standard), page 11-3

Removing All VNDS Elements Procedure for removing residual elements of the VNDS 4.0
(Advanced), page 11-5 installation (such as top-level Windows Registry keys and
Program Group shortcuts).

Perform this procedure ONLY if you need to completely
remove everything installed or generated by Cisco VNDS

4.0.
Removing Prior Cisco VNDS Release |Procedure for removing VNDS 3.5 following successful
After Software Update, page 11-7 installation of Cisco VNDS 4.0 and migration of product
configuration.

Use the “Uninstalling Cisco VNDS on Windows (Standard)” procedure on
page 11-3 to uninstall the current release. If you wish to completely remove all
traces of the current release from a machine, first perform “Uninstalling

Cisco VNDS on Windows (Standard)” procedure on page 11-3 then continue on
to “Removing All VNDS Elements (Advanced)” procedure on page 11-5.

To uninstall VNDS 1.1 after you update to the current release, perform
“Removing Prior Cisco VNDS Release After Software Update” procedure on
page 11-7.

Uninstalling Cisco VNDS on Windows (Standard)

Perform the following procedure to remove the VNDS 4.0 software from your
computer.

Stepl  Log into the Cisco VNDS host using an account with administrator privileges.

Step2  Stop services and exit the Control Panel.
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Step3  Open a command window and use the cd command to set the working directory
to the Cisco VNDS installation directory. An example installation directory might
be:

C:\Cisco\VNDServer\4.0.2 <build numbers

Step4  Stop all VNDS background services by entering the following command:
Windows: vnes.bat /svc_cmd stop ALL

Step5  Open the Windows Control Panel from the Start menu:
Start > Settings > Control Panel

Step6  In the Windows Control Panel, double-click Add/Remove Programs.

Step7  Scroll down the list of installed programs, select the entry for
Cisco Virtual Network Data Server 4.0, and click Remove.

The Windows uninstaller removes the following items:
*  Windows services
* Desktop shortcut
* Most Windows Registry entries
*  Most Program Group shortcut entries
* Most of the installation directory

Step8  Delete the remnants of the corresponding installation directory. For example, the
installation directory might be:

C:\Cisco\VNDServer\4.0.2 <build numbers

After you complete this procedure, the following remain:
« top-level Windows Registry entry for the release
» top-level Program Group shortcut for the release
* VND Server temporary directory
* VND Server archive directory

o Jre directory

Installation Guide for Cisco Configuration Assurance Solution
m. OL-11600-01 |




| Chapter 11

Uninstalling Cisco Virtual Network Data Server

Uninstalling Cisco VNDS (Windows) W

Removing All VNDS Elements (Advanced)

N

Note

If you wish to completely remove all traces of Cisco Virtual Network Data Server
4.0 from a machine, first perform “Uninstalling Cisco VNDS on Windows
(Standard)” procedure on page 11-3 then use the “Removing All VNDS Elements
(Advanced)” procedure on page 11-5 to remove residual components of the
installation.

Perform this procedure ONLY if you need to completely remove everything
installed or generated by Cisco Virtual Network Data Server 4.0.

Removing All Cisco VNDS Elements

Step 1

Step 2
Step 3

Step 4

Step 5

Perform “Uninstalling Cisco VNDS on Windows (Standard)” procedure on
page 11-3 if you have not already done so.

Log into the VND Server host using an account with administrator privileges.
Delete the temporary directory. Typical temporary directory:

C:\op_admin\temp\vne

N

Note  If you have another VNDS release that you want to keep and it uses the
same parent directory, skip this step.

Delete the archive directory. Typical archive directory:
C:\op_admin\archive

A

Note  If you have another VNDS release that you want to keep and it uses the
same archive directory, skip this step.

Delete the gava Jre directory (if it remains). This directory is located under the
parent install directory. Typical Jre directory:

C:\Cisco\Jre
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Step 6
Step 7

Warning

Step 8

Step 9
Step 10

Step 11

Step 12

>
Note  If you have another VNDS release that you want to keep and it is installed

to the same parent directory (for example C:\Cisco), skip this step.
Otherwise, you'll remove the Jre used by a release you want to keep.

Delete the top-level Program Group shortcut for the release. All users have a
shortcut. Delete the cisco Virtual Network Data Server 2.0 shortcut from:

C:\Documents and Settings\All Users\Start Menu\Programs

Start regedit: From the Windows Start menu, choose Run; then enter regedit and
click OK.

Be very careful when you edit the system registry. Incorrect changes to the
registry can cause your Windows system to become unstable. You might
want to create a backup before editing the registry.

In the Windows Registry Editor, find and select the registry key for the software
being removed. Example registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\OPNET Technologies\
Cisco VND Server 4.0.2

Select Delete from the menu to delete the entry.

Verify that the uninstaller entry in the Registry has been removed. Remove the
entry if it still exists in the Registry at the following location:

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion)\
Uninstall

Example entry:
Cisco Virtual Network Data Server 2.0

Verify that any services installed by Virtual Network Data Server are gone.
Remove the following services if they still exist in the Registry at the following
location:

HKEY LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services

-OPNETVNESXXX
-OPNETVnesXxxx
Where xxx is AdapterServer, BootstrapService, etc.

Exit the Windows Registry Editor.
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At this point, Cisco Virtual Network Data Server is completely removed from
your system.

Removing Prior Cisco VNDS Release After Software Update

N

Note

Perform this procedure if you wish to remove Cisco Virtual Network Data Server
3.5 after you have installed Cisco VNDS 4.0 and migrated your product
configuration.

If you want to remove Cisco VNDS 3.5 completely from a machine that has not
been updated to the current release, Refer to the Installation Guide for Cisco
Configuration Assurance Solution 1.1 or Network Planning Solution 1.1.

Do not run the Windows uninstaller for a previous VNDS release after you have
updated to the current software release. Doing so may impact the current release.

Removing a Prior VNDS Release After Update

Step 1

Step 2

Step 3

Delete the VNDS 3.5 install directory. Typical default install directory:
C:\Cisco\CiscoCAS\VNEServer\3.5.2 <build numbers>
C:\Cisco\CiscoNPSSPM1.1\VNEServer\3.5.2 1107<build numbers>

Delete the following VNDS Program Group shortcuts from the Program Group
menu for the appropriate Cisco solution bundle (Cisco Configuration Assurance
Solution, Cisco Network Planning Solution, etc.):

* Virtual Network Data Server

* Open Virtual Network Data Server File Log Viewer
Example Program Group menus for Cisco solution bundles:

C:\Documents and Settings\All Users\Start Menu\Programs\Cisco
Configuration Assurance Solution 1.1

C:\Documents and Settings\All Users\Start Menu\Programs\Cisco Network
Planning Solution 1.1 - SPM

If the Program Group menu for the appropriate Cisco solution bundle is now
empty, delete the menu.
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_A

Warning

Step 4

Step 5
Step 6

Step 7

Be very careful when you edit the system registry. Incorrect changes to the
registry can cause your Windows system to become unstable. You might
want to create a backup before editing the registry.

In the Windows Registry Editor, find and select the registry key for the software
being removed. Example registry key:

HKEYiLOCALiMACHINE\SOFTWARE\OPNET Technologies\
Cisco Configuration Assurance Solution 1.1\OPNET VNE Server 3.5.2.

Select Delete from the menu to delete the entry.
Remove the uninstaller entry in the Registry at the following location:

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion)\
Uninstall

Example entry names:

Cisco Configuration Assurance Solution 1.1 Virtual Network Data
Server

Cisco Configuration Assurance Solution 1.1 - Service Provider Module
- Virtual Network Data Server

Exit the Windows Registry Editor.

Uninstalling Cisco VNDS (Linux)

Step 1
Step 2

Step 3

Step 4

Perform the following procedure to remove the VNDS software from your
computer.

Stop services and exit the Control Panel.

Open a command window and use the cd command to set the working directory
to the VNDS installation directory. An example installation directory might be:

/opt/cisco/VNDServer/4.0.2 <build number>

Enter the following command:
./vnes.sh -c stop ALL

Close the window or cd up one level.
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Step5  Enter the following command:
rm -rf <vnds_ installs

where <install pathsis the VNDS installation directory.

Step6 At this point, there are still some daemon scripts remaining in the /etc directory.
Removing these scripts is optional. To remove these scripts, open a command
window and enter the following commands:

cd /etc/init.d
run "rm OPNET*"
run "rm tomcat.sh"

run "rm vnetomcat.sh"

Uninstalling a License Server

This section describes how to uninstall a license server from the Cisco VNDS
host.

A

Note In previous versions of Cisco VNDS, a license server that was installed with the
software was uninstalled with the Cisco VNDS software. If you installed a local
license server with Cisco VNDS 3.5, refer to the Installation Guide for the
previous release.

If you installed a local license server with Cisco VNDS 4.0, use the following
procedure to remove it.

Uninstalling License Server (Windows)

_A

Warning Do not uninstall the license server until another license server can be set up
elsewhere. You must deregister licenses and move them to the new license
server then redirect all impacted solution components to the new license
server before you uninstall the old license server.

Step1  Deregister all active licenses for the license server. Use the “Deregistering a
License” procedure on page 9-8.

Installation Guide for Cisco Configuration Assurance Solution
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Step 2

Step 3
Step 4

Step 5

_A

Warning

Step 6

Open the Windows Control Panel from the Start menu:
Start > Settings > Control Panel
In the Windows Control Panel, double-click Add/Remove Programs.

Scroll down the list of installed programs, select the entry for OPNET License
Server 12.0, and click Remove.

(Optional) Remove the license directory (for example, C:\OPNET_license dir).

Be very careful when you edit the system registry. Incorrect changes to the
registry can cause your Windows system to become unstable. You might
want to create a backup before editing the registry.

(Optional) Verify that the registry key has been removed. In the Windows Registry
Editor, find and select the registry key for the software being removed. Example
registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\OPNET Te chnologies\
OPNET License Server 12.0\12.0.A

If the entry exists, select Delete from the menu to remove it.

Uninstalling License Server (Linux)

A

Warning

Step 1
Step 2

Step 3

Step 4

Do not uninstall the license server until another license server can be set up
elsewhere. You must deregister licenses and move them to the new license
server then redirect all impacted solution components to the new license
server before you uninstall the old license server.

Deregister all active licenses for the license server.

Open a command window and use the cd command to set the working directory
to the license server installation directory (for example,
/usr/bin/OPNET/12.0.A/).

Enter the following command to delete the contents of the license server
installation directory:

rm -rf *

Remove the startup folder by entering the following command:
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rm /etc/rc3.d/S99%cpnet lic server

Step5  (Optional) Remove the license directory.

Installation Guide for Cisco Configuration Assurance Solution
[ oL-11600-01 .m



Chapter 11 Uninstalling Cisco Virtual Network Data Server |

[ | Uninstalling a License Server

Installation Guide for Cisco Configuration Assurance Solution
m. OL-11600-01 |




CHAPTER 12

Uninstalling Cisco Report Server

This chapter contains the following sections:
» Uninstalling Cisco Report Server (Windows), page 12-1
» Uninstalling Cisco Report Server (Linux), page 12-2

Uninstalling Cisco Report Server (Windows)

Step 1

Step 2
Step 3

Step 4

Open the Windows Control Panel from the Start menu:
Start > Settings > Control Panel
In the Windows Control Panel, double-click Add/Remove Programs.

Scroll down the list of installed programs, select the entry for the
Cisco Report Server release you want to remove, and click Remove. For example,
you might see the following entry:

» Cisco Configuration Assurance Solution 2.0 Cisco Report Server

Delete the corresponding install directory. Thus, if your version of Report Server
is installed in c:\Ccisco\ReportServer\2.5.2, delete the 2.5.2 directory.
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N
Note ~ When you uninstall a previous release of Cisco Report Server, the

Cisco Report Server service registered to the current release will be stopped. Use
the Windows Service Manager to re-start the Cisco Report Server service.

Uninstalling Cisco Report Server (Linux)

Stepl Loginas root.
Step2  Open a command prompt window.

Step3  Move to the parent directory of the Report Server installation. Thus, if you
installed Report Server in /opt/cisco, enter the following command:

cd /opt/cisco
Step4  Enter the following command:
./ReportServer/2.5.2/UninstallerData/Uninstall_Cisco_Report_Server_ 2.0
)

Note  You must enter this command from the parent directory and specify the
path name to the UninstallerData directory.

Step5  Delete the ReportServer directory by entering the following command:

rm -rf ReportServer

A

Caution  The following step will delete all the generated security keys for Report Server.
Perform the following step ONLY if there are no other programs (such as
Cisco Virtual Network Data Server) that are using the security directory.

Step6  Delete the Security directory by entering the following command:

rm -rf Security

Installation Guide for Cisco Configuration Assurance Solution
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APPENDIX ‘ \

Oracle Procedures (Windows)

This appendix includes a series of procedures for installing Oracle software for
use with Cisco Virtual Network Data Server. For information about when to
perform each procedure, see the “Installation Workflows” section on page 5-2.

The instructions in this appendix are included for the convenience of Cisco CAS
users. For detailed information about using Oracle products, consult the Oracle
product documentation or Oracle technical support.

Oracle9i Installation Procedures

Installing the Oracle9i Database (Windows)

A

Warning

Use caution when installing Oracle for use with VNDS. Recovery is difficult
if Oracle is incorrectly installed.

You can install the Oracle database on the same host as VNDS or on a different
host. Install the database on the appropriate host using Installing the Oracle 9i
Database on Windows, page A-2.
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Installing the Oracle 9i Database on Windows

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Log into the host as Administrator or as a user with full administrative privileges.
If you are not logged in with the proper privileges, log off and log on with an
appropriate account.

Insert the Oracle installation CD into the CD drive of the host for the database. If
the installer does not start automatically, use Start > Run to execute Oracle’s
setup.exe program.

The installer displays a welcome panel.
Press Next to proceed to the File Locations panel.

The installer prompts you for an installation path in the File Locations panel.
Oracle (9.2.0.1.0) requires about 2.8 GB of disk space.

Enter an installation path that resides on a disk with adequate free space. Press
Next to proceed.

The installer prompts you for the Oracle product to install in the Avaiiabie
products panel.

Select the oracie9i patabase product. Press Next to proceed.

The installer prompts you for the type of installation in the rnstaliation Types
panel.

Select a pPersonal, Standard, Or Enterprise edition installation. Any of these
editions can be used with VNDS. The Enterprise edition is recommended for best
scalability and performance.

Press Next to proceed.

The installer prompts you for the type of database in the patabase
Configuration panel.

Select General Purpose. Press Next to proceed.

The installer prompts you for the port number for the Oracle MTS Recovery
Service.

Leave the default port number (2030) unchanged. Press Next to proceed.

The installer prompts you for a global database name (GDN) in the patabase
Identification panel.

VNDS will work with any valid GDN and SID that Oracle accepts.

Answer with a GDN constructed according to the following rules:
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Global Database Name = o92a<names.<domains.com
An example: o92avnes.opnet.com

S

Note  If the first portion of the GDN exceeds 8 characters, the Oracle installer
will block installation.

The installer prompts you for a system ID (SID). Some examples follow:
* 092a

*« 092avnes

* vnesDB
Step 10 Enter the SID you want to use. After entering a GDN and SID, press Next to
continue to the patabase File Location panel.
The installer prompts you for the Database File Location.
Step 11  Keep the default location and press Next to proceed.
The installer prompts you for the Database Character Set.
~
Note  To view the list of supported Oracle database and national character sets
for use with VNDS, refer to Cisco Virtual Network Data Server: System
Requirements, page 3-1. Choose a supported character set and press Next
to proceed with file installation.
The Oracle installer takes up to 30 minutes to copy files to the installation
directories. Oracle9i has three installation CDs. The installer prompts you to
insert a new CD in the CD drive when it is ready to copy files from the next CD.
During this time, Install, Configuration Tools and Database Creation
panels appear.
Step 12 Press Next or OK to proceed through these panels.
)
Note A window titled HTTP Server may launch at this point. You can close this
window.
An installation summary panel appears.
Installation Guide for Cisco Configuration Assurance Solution
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Step 13

Step 14

Step 15

Step 16

Note

Press Install to proceed.

The Database Configuration Assistant prompts you for new passwords for the
SYS and SYSTEM accounts.

Enter the passwords that you want to use for these accounts, and press OK when
done.

When installation is complete, an £nd of Installationpanel appears. Press Exit
to close the Oracle installer.

S

Note  You do not need to create a user account for VNDS at this time. This is
done after VNDS installation.

Record the Oracle GDN, SID, install path and database hostname in Table A-1 on
page A-14.

Installation logs are located here:

C:\Program Files\Oracle\Inventory\logs\installActions.log

If you run the Oracle installer again, the install actions log is renamed with an
embedded date-stamped name such as: installActions2002-01-24 xxx.

Oracle9i (9.2.0.1.0) installation is now complete.

After VNDS is installed, a final configuration step is required to finish Oracle
setup for VNDS. This step is described in “Configuring the Oracle Database for
Cisco VNDS (Windows)” section on page 5-17, but is not performed until after
installation of VNDS.

Proceed at this time to “Oracle9i Installation Procedures” section on page A-1 and
then to “Installing Cisco VNDS (Windows)” section on page 5-6.

About Oracle Services

After Oracle installation, several Windows services are created. VNDS only
requires the Oracle services shown below. These Windows services should be
configured to automatically start when the PC is booted. All other Oracle services
may be configured for a manual start and stopped unless specifically needed for
other uses. The following services are required for VNDS to run:

* OracleOraHome92TNSListener
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® OracleService<DB SID>

Installing the Oracle9i Client (Windows)

A

Warning

Use caution when installing Oracle for use with VNDS. Recovery is difficult
if Oracle is incorrectly installed.

If the Oracle database is installed on a different machine that the VNDS software,
you must install the Oracle client on the VNDS host. The Oracle client is required
by VNDS to communicate with an Oracle database located on another host.
Perform “Installing the Oracle 9i Client on Windows” section on page A-5 to
install the Oracle 9i client.

Installing the Oracle 9i Client on Windows

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Log into the host as Administrator or as a user with full administrative privileges.
If you are not logged in with the proper privileges, log off and log on with an
appropriate account.

Insert the Oracle installation CD into the CD drive of the host for VNDS. If the
installer does not start automatically, use Start > Run to execute Oracle’s
setup.exe program.

The installer displays a welcome panel.
Press Next to proceed to the File Locations panel.

The installer prompts you for an installation path in the File Locations panel.
Oracle Client (9.2.0.1.0) requires about 200 MB of disk space.

Enter an installation path that resides on a disk with adequate free space. Press
Next to proceed.

The installer prompts you for the Oracle product to install.
Select the Oracle9i Client product. Press Next to proceed.

The installer prompts you for the type of installation in the rnstallation Types
panel.

Select Runtime. Press Next to proceed to the summary panel.

An installation summary panel appears.
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Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Step 15

Press Install at this panel to begin Oracle installation. The Oracle installer takes
up to 30 minutes to copy files to the installation directories.

a~

Note  The final installation tasks involve setting up Net services using the Net
Configuration Assistant.

Press Next at the configuration Tools panel.

The installer prompts you for whether you want to use a directory service at the
Net Configuration Assistant panel.

Select No, and press Next.

The installer prompts you for the version of Oracle used by the database at the
Database Version panel.

Select Oracle 8i or later database, and press Next.
The installer prompts you for a database service name at the service Name panel.

Enter the Global Database Name used during Oracle database installation on the
database host. This name should be the same as the Database TNS Service Name
collected in Table A-1 on page A-14. Press Next.

The installer prompts you for the communication protocol to use at the select
pProtocols panel.

Select the appropriate protocol to use (e.g. TCP), and press Next.
The installer prompts you for the database host name.

Enter the hostname as an IP address or a fully qualified domain name, and press
Next.

The installer prompts you for whether you want to test the database connection.
Answer Yes, and press Next.
The installer displays the test status in a test result panel.

Press Next.

N

Note Investigate and resolve any problems if the connection test fails.

The installer prompts you for whether or not you want to configure another
service name.

Installation Guide for Cisco Configuration Assurance Solution
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Step 16

Step 17

Step 18

Step 19

Oracle10g Installation Procedures 1l

Answer No, and press Next.

A Configuration Complete panel appears.

Press Next.

Another completion panel appears.

Press Finish.

The installer displays an End of Installation panel.

Press Exit to close the Oracle installer.

Installation logs are located here:
C:\Program Files\Oracle\Inventory\logs\installActions.log

If you run the Oracle installer again, the install actions log is renamed with an
embedded date-stamped name such as: installActions2002-01-24_ xxx.

Proceed at this time to Oracle9i Installation Procedures, page A-1, and then to
Installing Cisco VNDS (Windows), page 5-6.

OraclelOg Installation Procedures

Installing the Oracle10g Database (Windows)

A

Warning

Note

Use caution when installing Oracle for use with VNDS. Recovery is difficult
if Oracle is incorrectly installed.

You can install the Oracle database on the same host as VNDS or on a different
host. Install the database on the appropriate host using Installing the Oracle 10g
Database (Windows), page A-8.

Oracle10g requires a static IP address on the database host machine. If the
database host has a dynamically assigned IP address, install the Microsoft
Loopback Adapter before you install Oracle10g.
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Installing the Oracle 10g Database (Windows)

Step1  Log into the host as Administrator or as a user with full administrative privileges.
If you are not logged in with the proper privileges, log off and log on with an
appropriate account.

Step2  Insert the Oracle installation CD into the CD drive of the host for the database. If
the installer does not start automatically, use Start > Run to execute Oracle’s
setup.exe program.

The installer displays an rnstallation Method panel.

Step3  Select Basic Installation in the Installation Method panel and enter values for
Basic Installation configuration.

a. [Enter an installation path into the Oracle Home Location field. Make sure
that it resides on a disk with adequate free space.

Oracle (10.2.0.1.0) requires about 2.8 GB of space.
b. Select the Installation Type.

Select a Personal, Standard, or Enterprise edition installation. Any of these
editions can be used with VNDS. The Enterprise edition is recommended for
best scalability and performance.

c. Make sure that Create Starter Database is selected.

d. Specify the Global Database Name (GDN).
VNDS will work with any valid GDN that Oracle accepts.
Enter a GDN constructed according to the following rules:

Global Database Name = <database names>.<database domain> where
<database domain> is optional.

Some examples:

ol0gvnes

vnes

vnes.opnet.com

e. Type the password that will be used for the SYS, SYSTEM, SYSMAN, and
DBSNMP accounts into the Database Password and Confirm Password fields.

f. Press Next to proceed.

Step4 A progress dialog displays while Oracle runs system verification checks.
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The product-Specific Prerequisite Checks panel displays.

Step5  Review the results of the prerequisite checks and resolve errors and warnings
before proceeding.

Step6  Press Next to proceed.
A Summary panel displays.

Step7  Press Install to proceed with installation.
An Install panel displays progress.
Next a Configuration Assistants panel displays progress.
A Database Configuration Assistant dialog notifies you when database
creation is complete.

Step8  Record the Oracle GDN, SID, install path and database hostname in Table A-1 on
page A-14.
You do not need to do any account or password management at this time. Creation
of the VNDS account is done after VNDS installation.

Step 9  Press OK in the patabase Configuration Assistant dialog to continue.
When configuration is complete, an znd of Installation panel displays.

Step 10  Press Exit to close the Oracle installer.
~
Note A web browser with the Oracle Enterprise Manager may open. You can

close this window.
Installation logs are located here:
C:\Program Files\Oracle\Inventory\logs\installActions.log
If you run the Oracle installer again, the install actions log is renamed with an
embedded datestamped name such as: installActions<date times.log.
Oracle10g (10.2.0.1.0) installation is now complete.
After VNDS is installed, a final configuration step is required to finish Oracle
setup for VNDS. This step is described at “Configuring the Oracle Database for
Cisco VNDS (Windows)” section on page 5-17, but is not performed until after
installation of VNDS.
Installation Guide for Cisco Configuration Assurance Solution
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Proceed at this time to Oracle9i Installation Procedures, page A-1 and then to
Installing Cisco VNDS (Windows), page 5-6.

Installing the Oracle10g Client (Windows)

A

Warning

Use caution when installing Oracle for use with VNDS. Recovery is difficult
if Oracle is incorrectly installed.

If the Oracle database is installed on a different machine that the VNDS software,
you must install the Oracle client on the VNDS host. The Oracle client is required
by VNDS to communicate with an Oracle database located on another host.
Perform Installing the Oracle 10g Client (Windows), page A-10 to install the
Oracle 10g client.

Installing the Oracle 10g Client (Windows)

Step 1

Step 2

Step 3

Step 4

Step 5

Log into the host as Administrator or as a user with full administrative privileges.
If you are not logged in with the proper privileges, log off and log on with an
appropriate account.

Insert the Oracle installation CD into the CD drive of the host for VNDS. If the
installer does not start automatically, use Start > Run to execute Oracle’s
setup.exe program.

The installer displays a welcome panel.

Press Next to proceed to the rnstallation Type panel.

The installer prompts you for the type of client installation.

Select Runtime then press Next.

The installer displays the specify Home Details panel.

Specify the Path.

Oracle Runtime Client (10.2.0.1.0) requires about 213 MB of disk space.

N

Note Do not modify the Name field in the Specify Home Details panel. Use the
value that the Oracle installer provides.

Installation Guide for Cisco Configuration Assurance Solution
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Step 6

Step 7

Step 8

Step 9

Step 10
Step 11
Step 12

Step 13

Step 14

Step 15

Oracle10g Installation Procedures 1l

Enter an installation path that resides on a disk with adequate free space. Press
Next to proceed.

The Oracle installer performs prerequisite checks then displays the results in the
Product-Specific Prerequisite Checks panel.

Press Next to proceed.
The summary panel displays.

Press Install at this panel to begin Oracle installation. The Oracle installer takes
several minutes to copy files to the installation directories.

The rnstal1i panel displays progress then the configuration Assistants panel
displays.

After a moment, the oracle Net Configuration Assistant: Welcome dialog
displays.

Press Next.

The oracie Net cConfiguration Assistant: Done dialog displays.
Press Finish.

The End of Installation panel displays.

Press Exit.

)

Note  The final installation tasks involve setting up Net services using the
Oracle Net Configuration Assistant.

Select Programs > Oracle - Oracle - OraClient10g_homel >
Configuration and Migration Tools > Net Configuration Assistant from the
Windows Start menu.

The Oracle Net Configuration Assistant opens and prompts you to choose the
configuration you would like to do at the weicome panel.

Select Local Net Service Name configuration and press Next.

The Oracle Net Configuration Assistant opens and prompts you to specify an
action at the Net Service Name Configuration panel.

Select Add then press Next.

The Oracle Net Configuration Assistant prompts you for a database service name
at the Net service Name Configuration, Service Name panel.
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Step 16

Step 17

Step 18

Step 19

Step 20

Step 21

Step 22

Step 23

Step 24

Enter the Global Database Name used during Oracle database installation on the
database host. This name should be the same as the Database TNS Service Name
collected in Table A-1 on page A-14. Press Next.

The Oracle Net Configuration Assistant prompts you for the communication
protocol to use at the Nvet Service Name Configuration, Select Protocols
panel.

Select the appropriate protocol to use (e.g. TCP), and press Next.

The Oracle Net Configuration Assistant prompts you for the database host name
and TCP/IP port number.

Enter the hostname as an IP address or a fully qualified domain name, and press
Next.

The Oracle Net Configuration Assistant prompts you for whether you want to test
the database connection.

Answer Yes, and press Next.
The test status displays.

N

Note  Investigate and resolve any problems if the connection test fails. If the test
did not succeed, make sure that the username and password is valid for
the VNDS account that has been configured on the remote database.
Change the login, if required, and retest.

Press Next.
The Oracle Net Configuration Assistant prompts you for a net service name.

Leave the Net Service Name set to the global database name for the remote
database and press Next.

The Oracle Net Configuration Assistant prompts you for whether or not you want
to configure another service name.

Answer No, and press Next.

A Net Service Name Configuration panel displays.
Press Next.

The welcome panel displays.

Press Finish to close the Oracle Net Configuration Assistant.
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Collecting Oracle Database Access Information (Windows)

Step 25 Verify that a tnsnames.ora file has been created for the database client.

Look in <oracle homes\client 1\NETWORK\ADMIN directory (for example,
C:\oracle\product\lO.Z.O\CZient_l\NETWORK\ALWQ]O.

Installation logs are located here:
C:\Program Files\Oracle\Inventory\logs\installActions.log

If you run the Oracle installer again, the install actions log is renamed with an
embedded date-stamped name such as: installActions<date times>.log.

Now proceed to the following procedures.
For VNDS on Windows:
a. OracleYi Installation Procedures, page A-1
b. Installing Cisco VNDS (Windows), page 5-6.
For VNDS on Linux:
a. Collecting Oracle Database Access Information (Linux), page B-3

b. Installing Cisco VNDS (Linux), page 6-4.

Collecting Oracle Database Access Information
(Windows)

The VNDS installer prompts for database access information. Before beginning
installation, collect the database access information listed in Table A-1 on

page A-14. The database administrator can supply the database access
information that you need. Print out the installation instructions and write down
the database access information in the Table A-1 on page A-14 for reference
during installation. Continue with Installing Cisco VNDS (Windows), page 5-6.

The Database Account User Name in Table A-1 on page A-14 is the account used
by VNDS to access network data stored in the database. This account is created
after VNDS is installed using the user name and password entered during VNDS
installation.
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A

Warning DO NOT use SYS or SYSTEM for the Database Account User Name.

Table A-1

Database Access Information Worksheet

Access Item

Value

Description

Database TNS Service Name
(alias for Database GDN)

The TNS Net Service name used for the local or
remote database. Refer to Locating a Database
Net Service Name in tnsnames.ora (Windows),
page A-16 in the Appendix for instructions on
locating the service name.

Database SID

The database SID.

Database hostname

The IP address or fully qualified domain name for
the database host. Only needed for remote
databases.

Oracle Home (installation)
directory

The Oracle installation directory on the database
host. Only needed for remote databases.

Oracle Oradata Parent directory

The parent directory to the Oracle oradata
directory on the database host. Only needed for
remote databases.

Database account user name

User name of the account used to access the
database. DO NOT use the Oracle SYS or
SYSTEM accounts.

Database account password

Password for the account used to access the
database.

Installing Oracle TopLink (Windows)

The Cisco VNDS program requires access to an installation of Oracle 9i
Application Server Toplink that is patched to release 9.0.3.5. This section
describes how to install Toplink 9.0.3.5 on your system. Install Toplink on the
same system as Cisco Virtual Network Data Server.
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Installing Oracle TopLink (Windows)

Note  VND Server requires access to Oracle TopLink 9.0.3.5. This is true regardless of
the version of Oracle used for the VNDS database.

Note  You must perform the following procedure before you install
Cisco Virtual Network Data Server.

Installing Toplink 9.0.3.5 (Windows)

Step1  Download or copy the required Oracle Toplink components into a working
directory:

» Oracle Toplink 9.0.3.0 (A99417-01.zip)
* Oracle Toplink 9.0.3.5 patch (p3188702_9031_GENERIC.zip)

Step2  Create a working directory on your system. Copy the downloaded Oracle Toplink
9.0.3.0 and 9.0.3.5 zip files to this directory.

Step3  Unzip the Oracle Toplink 9.0.3.0 archive, A99417-01.zip, into the working
directory.

Step4  Execute the Toplink 9.0.3.0 installer, toplink903-windows.exe:

a. At the introduction panel, click Next. The installer prompts you for the
installation folder.

S

Note If you already have an Oracle installation on this system, the default
Toplink installation folder will be in your Oracle installation. Cisco
recommends that you use this folder. Write down the installation folder
you choose; you will need it later during installation of
Cisco Virtual Network Data Server.

b. Select an install folder and click Next. In the remaining panels, the installer
prompts you for:

— Shortcut Location (select your preference)
— Toplink Features (select Full Install)

— Viewing Release Notes  (select your preference)

Installation Guide for Cisco Configuration Assurance Solution
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c. Work through the remaining installer panels and enter the preferences in Step
b. Click Done in the Install of TopLink Complete panel to exit the installer.

Step5 Do the following steps to install the Toplink 9.0.3.5 patch.

a. Open a window to the working directory that contains the Toplink patch,
p3188702_9031_GENERIC.zip.

b. Unzip the Oracle Toplink patch archive, p3188702_9031_GENERIC.zip, into
the Toplink installation directory. For example, if you installed Toplink to
C:\oracle\ora92\toplink, select this path as the extraction path for the archive.

c. If you are prompted to confirm file overwrite, select "Yes to All".
d. Close the archive application (WinZip or similar application) when done.

e. Verify that the Toplink installation has the files required by
Cisco Virtual Network Data Server. The following files should exist in the
<toplink installs>\core\lib directory:

— tl_core.jar
— tl_tools.jar
— tl_x.jar

At this point, Toplink 9.0.3.5 is installed on your system and ready for access
during Cisco Virtual Network Data Server installation. Proceed to the next step of
the installation workflow (as described in Installation Workflows, page 5-2).

Locating a Database Net Service Name in
tnsnames.ora (Windows)

VNDS uses a database’s Oracle Net service name for connection to the database.
This is true whether VNDS uses a local or remote database. The database service
name is located in the tnsnames.ora file. This file is located in the <oracie
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Locating a Database Net Service Name in tnsnames.ora (Windows) W
install dirs>\ora92\network\Admin for Oracle9i and at <oracle install
dirs\product\10.2.0\db 1\NETWORK\ADMIN directory for Oracle10g. A sample
file is shown below.

In this sample file, there are three entries. The 092AML14 .0PNET. CcOM entry
(highlighted) represents the database service name. Each entry has a <net
service name> = () structure. The text string preceding the “=” is the service
name. In this example, you use 092AML14 .0PNET.COM as the service name for
VNDS installation.
Note that this file has entries for other Oracle Net services and may contain entries
for more than one database. If the Oracle installation you are using supports other
products, contact the database administrator for the service name you should use.
# TNSNAMES.ORA Network Configuration File:
D:\oracle\ora92\network\admin\tnsnames.ora
# Generated by Oracle configuration tools.
092AML14 .OPNET.COM =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP) (HOST = mlpcl4) (PORT = 1521))
)
(CONNECT DATA =
(SERVICE_NAME = o92amll4)
)
)
EXTPROC_CONNECTION DATA.OPNET.COM =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = IPC) (KEY = EXTPROCO))
)
(CONNECT_DATA =
(SID = PLSExtProc)
(PRESENTATION = RO)
)
)
INST1_HTTP.OPNET.COM =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP) (HOST = mlpcl4) (PORT = 1521))
)
(CONNECT_DATA =
(SERVER = SHARED)
(SERVICE_NAME = o92amll4)
(PRESENTATION = http://admin)
Installation Guide for Cisco Configuration Assurance Solution
[ oL-11600-01 .m




Appendix A Oracle Procedures (Windows) |

[ | Locating a Database Net Service Name in tnsnames.ora (Windows)

Installation Guide for Cisco Configuration Assurance Solution
m. OL-11600-01 |



Note

APPENDIX B

Oracle Procedures (Linux)

This appendix includes a set of procedures for installing Oracle software for use
with Cisco Virtual Network Data Server. For information about when to perform
each procedure, see the “Installation Workflows: Overview” section on page 6-2.

The instructions in this appendix are included for the convenience of Cisco CAS
users. For detailed information about using Oracle products, consult the Oracle
product documentation or Oracle technical support.

Oracle Installation Procedures

Note

The procedures for installing Oracle on Linux can vary, depending on the versions
of Oracle and Linux as well as platform-specific parameters. Installing Oracle
might also require changes in kernel settings, updating system patches, and other
system administration tasks. Work with your Database Administrator and refer to
the Oracle Installation Guide and other relevant Oracle documentation to
complete the installation.

Check the /etc/oratab file and verify that the database instance you are using
can be started by Oracle scripts. The oratab entry for the database instance name
you are using should end in “:Y”. If it does not, work with your database
administrator to change this setting to allow database startup.
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Configuring the Environment for the oracle Account (Linux)

Step1  Verify/configure the environment for the oracle account.

a. Open /oracle/.bash profile with a text editor of your choice.

N

Note If you are using another shell, examine the appropriate file.

b. Confirm that it has the following entries. Manually add the entries, if needed.

ORACLE_HOME=<oracle home>

ORACLE_SID=<dbSID>

PATH=$ORACLE_HOME/bin:$PATH

export PATH

export ORACLE HOME ORACLE SID

where <dbs1ps is the database SID (for example, 092m123)

and <oracle home> is the Oracle installation directory (for example,
/u01l/app/oracle/product/9.2.0)

Configuring Permissions for Oracle Directories (Linux)

Step1l  Assign read and execute permissions for all users to the bin, lib and jdbc
directories in $ORACLE_HOME.

a. Login as oracle.

b. Use the following commands to modify directory permissions.

chmod 755 $ORACLE_HOME/bin
chmod 755 $ORACLE_HOME/1ib
chmod 755 $ORACLE7HOME/jdbC
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Collecting Oracle Database Access Information (Linux) W

Collecting Oracle Database Access Information

(Linux)

A

The VNDS installer prompts for database access information. Before beginning
installation, collect the database access information listed in Table B-1. The
database administrator can supply the database access information that you need.
Print out the installation instructions and write down the database access
information in the Table B-1 for reference during installation. Continue with
installing Cisco VNDS.

The Database Account User Name in Table B-1 is the account used by VNDS to
access network data stored in the database. This account is created after VNDS is
installed using the user name and password entered during VNDS installation.

Warning DO NOT use SYS or SYSTEM for the Database Account User Name.
Table B-1 Database Access Information Worksheet
Access Item Value Description
Database TNS Service Name The TNS Net Service name used for the local or
(alias for Database GDN) remote database. Refer to Locating a Database

Net Service Name in tnsnames.ora (Linux),
page B-6 in the Appendix for instructions on
locating the service name.

Database SID

The database SID.

Database hostname

The IP address or fully qualified domain name for
the database host.

Oracle Home (installation) The Oracle installation directory on the database
directory host.
Oracle Oradata Parent directory The parent directory to the Oracle oradata

directory on the database host.

[ oL-11600-01

Installation Guide for Cisco Configuration Assurance Solution




Appendix B Oracle Procedures (Linux) |

[ | Installing Oracle TopLink (Linux)

Table B-1 Database Access Information Worksheet (continued)
Access Item Value Description
Database account user name User name of the account used to access the

database. DO NOT use the Oracle SYS or
SYSTEM accounts.

Database account password Password for the account used to access the
database.

Installing Oracle TopLink (Linux)

The VNDS program requires access to an installation of Oracle 9i Application
Server Toplink that is patched to release 9.0.3.5. This section describes how to
install Toplink 9.0.3.5 on your system. Install Toplink on the same system as
Cisco Virtual Network Data Server.

Note  VND Server requires access to Oracle TopLink 9.0.3.5. This is true regardless of
the version of Oracle used for the VNDS database.

Note  You must perform the following procedure before you install
Cisco Virtual Network Data Server.

Installing Toplink 9.0.3.5 (Linux)

Step1  Log into your system using the account used to operate Cisco VNDS.

Step2  Download or copy the required Oracle Toplink components into a working
directory:

* Oracle Toplink 9.0.3.0 (A99417-01.zip)
e Oracle Toplink 9.0.3.5 patch (p3188702_9031_GENERIC.zip)

Step3  Create a working directory on your system. Copy the downloaded Oracle Toplink
9.0.3.0 and 9.0.3.5 zip files to this directory.
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Installing Oracle TopLink (Linux)

Step 4  Unzip the Oracle Toplink 9.0.3.0 archive into the working directory. To do this,
enter the following command:
unzip -d <working dir> <zip files
Step5  Use the gzip command to expand the GZ file. To do this, enter the following
command:
gunzip toplink903-unix.tar.gz
Step6  Use the tar command to expand the TAR file. To do this, enter the following
command:
tar -xvf toplink903-unix.tar
This command creates a toplink directory under the working directory.
Step 7 Do the following steps to install the Toplink 9.0.3.5 patch.

a. Open a window to the working directory that contains the Toplink patch,
p3188702_9031_GENERIC.zip.

b. Unzip the Oracle Toplink patch archive, p3188702_9031_GENERIC.zip, into
the Toplink installation directory. To do this, enter the following command:
unzip -d <working dirs/toplink p3188702 9031 GENERIC.zip
For example, if you installed Toplink to /uol/app/oracle/9.2.0/toplink,
select this path as the extraction path for the archive.

c. If you are prompted to confirm file overwrite, select [A] for "Yes to All".

d. Verify that the Toplink installation has the files required by
Cisco Virtual Network Data Server. The following files should exist in the
<toplink installs>/core/lib directory:

— tl_core.jar

— tl_tools.jar

— tl_x.jar
At this point, Toplink 9.0.3.5 is installed on your system and ready for access
during Cisco Virtual Network Data Server installation. Proceed to the next step of
the installation workflow (as described in Installation Workflows, page 5-2).
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Locating a Database Net Service Name in
tnsnames.ora (Linux)

VNDS uses a database’s Oracle Net service name for connection to the database.
This is true whether VNDS uses a local or remote database. The database service
name is located in the tnsnames. ora file. This file is located in the following
directory:

Oracle 9i: <oracle install dirs/oracle/product/9.2.0/network/Admin
Oraclel0g: <oracle install dir>/oracle/product/10.2.0/NETWORK/ADMIN

In the following example file, there are three entries. The 092aAML14 .0PNET. COM
entry (highlighted) represents the database service name. Each entry has a <net

[T3EL

service name> = () structure. The text string preceding the “=” is the service
name. In this example, you use 092AML14 .0PNET.COM as the service name for
VNDS installation.

Note that this file has entries for other Oracle Net services and may contain entries
for more than one database. If the Oracle installation you are using supports other
products, contact the database administrator for the service name you should use.

# TNSNAMES.ORA Network Configuration File:
/uol/app/oracle/product/10.2.0/network/admin/tnsnames.ora
# Generated by Oracle configuration tools.

092AML14 .OPNET.COM =
(DESCRIPTION =
(ADDRESS LIST =
(ADDRESS = (PROTOCOL = TCP) (HOST = mlpcl4) (PORT = 1521))
)
(CONNECT DATA =
(SERVICE NAME = 092amll14)
)

EXTPROC_CONNECTION DATA.OPNET.COM =
(DESCRIPTION =

(ADDRESSiLIST =
(ADDRESS = (PROTOCOL = IPC) (KEY = EXTPROCO))

)

(CONNECTiDATA =
(SID = PLSExtProc)
(PRESENTATION = RO)

Installation Guide for Cisco Configuration Assurance Solution
m. OL-11600-01 |



| Appendix B Oracle Procedures (Linux)

Locating a Database Net Service Name in tnsnames.ora (Linux)

INST1 HTTP.OPNET.COM =
(DESCRIPTION =
(ADDRESS LIST =
(ADDRESS = (PROTOCOL = TCP) (HOST = mlpcl4) (PORT = 1521))
)
(CONNECT DATA =
(SERVER = SHARED)
(SERVICE NAME = 092amll4)
(PRESENTATION = http://admin)
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APPENDIX C

Errata

This appendix contains miscellaneous information that was unavailable when the
Cisco CAS documentation was published.

Additional Requirements for the “Cisco WAN
Manager” Adapter

The Cisco WAN Manager adapter includes a CWM Database Reader option. To
use this option, you must perform the following procedure.

For more information about the Cisco WAN Manager adapter, see the following
section of the Cisco Virtual Network Data Server documentation:

VNE Server User Guide > Importing Device and Configuration and Topology
> Cisco WAN Manager Import

Installing Additional Libraries to Allow Communication with the Cisco WAN Manager Database

Stepl1  Obtain and install the IBM Informix JDBC Driver libraries.
For information about purchasing the IBM Informix JDBC Driver, go to:
http://www.ibm.com/software/data/informix/tools/jdbc

For information about downloading an evaluation or trial version of the IBM
Informix JDBC Driver, go to :

http://www.ibm.com/software/data/informix/downloads.html
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Note You must install IBM Informix JDBC Driver version 2.21.JC4 or later.

Step2  After you obtain and successfully install the IBM Informix JDBC driver, you must
copy or link all files located in

<Informix JDBC Driver Install Directorys/lib
to the following directory:

<Cisco VNDS Install Directory>/ext

N

Note All files in the < Informix JDBC Driver Install Directorys/lib
directory should have a prefix of “ifx” and a suffix of “.jar”.

Step3  Restart Cisco VNDS services.
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APPENDIX D

Known lIssues

We highly recommend that you check, after installation and on a regular basis, for
software updates and maintenance information of any software, documentation,
model, or other components on http://www.cisco.com/techsupport.

You can search for additional online information regarding known product issues
and workarounds on the Cisco Quick Support page at OPNET Technologies
(http://www.opnet.com/support/cisco_gsp.html).
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